
                    

                                                                 

                                                                                                                       Объединяет лучшие достижения в области автоматизации производства 

MeMERSRSRSRSNetWorx�

For ControlNetFor ControlNetFor ControlNetFor ControlNetTM

Руководство по применению 

Документ № 9399-CNETGR-JAN00



Как связаться с  
Rockwell Software 

Телефон Службы технической поддержки - 440-646-5800
Факс Службы технической поддержки – 440-646-7801
Библиотека поддержки в World Wide Web - www.software.rockwell.com

Уведомление об 
авторском праве

© 2000 Rockwell Software Inc. Все права сохранены.
Отпечатано в Соединенных Штатах Америки.
Отдельные части защищены авторским правом компании Allen-Bradley, Inc. и используются с 
разрешения. Настоящее руководство и все сопутствующие продукты Rockwell Software защищены 
авторским правом Rockwell Software Inc. Всякое воспроизведение и/или распространение без 
предварительно полученного письменного согласия Rockwell Software Inc. строго воспрещается. За 
подробностями обращайтесь к лицензионному соглашению. 

Уведомление о 
товарных знаках

WINtelligent Series – зарегистрированный товарный знак. Логотип Rockwell Software, RSAlarm, 
RSAnimator, RSAssistant, RSBatch, RSBreakerBox, RSButton, RSChart, RSCompare, RSControlRoom, 
RSData, RSDataPlayer, RSEventMaster, RSGauge, RSJunctionBox, RSLogix Emulate 5, RSLogix Emu-
late 500, RSGuardian, RSHarmony, RSKyes, RSLadder, RSLadder 5, RSLader 500, RSLibrary Manager, 
RSLinx, RSLogix 5, RSLogix 500, RSLogix 5000, RSLogix Frameworks, RSMailman, RSNetworx for 
ControlNet, RSNetworx for DeviceNet, RSPortal, RSPower, RSPowerCFG, RSPowerRUN, RSPower-
Tools, RSRules, RSServer32, RSServer, RSServer OPC Toolkit, RSSidewinderX, RSSlider, RSSnapshot, 
RSSql, RSToolbox, RSToolPack I, RSToolPak II, RSTools, RSTrainer, RSTrend, RSTune, RSVessel, 
RSView32, RSView, RSVisualLogix, RSWheel, RSWire, RSWorkbench, RSWorkshop, SoftLogix 5, 
A.I. Series, Advanced Interface (A.I.) Series, AdvanceDDE, ControlGuardian, ControlView, INTER-
CHANGE, Packed DDE, Object Smart Path, Packed DDE, WINtelligent, WINtelligent LINX, WINtelli-
gent LOGIC 5, WINtelligent VIEW, WINtelligent RECIPE, WINtelligent VISION, WINtelligent 
VISION2 – товарные знаки Rockwell Software Inc.
PLC, PLC-2, PLC-3 и PLC-5 - зарегистрированные товарные знаки, а Data Highway Plus, DH+, DHII, 
DTL, ControlLogix, MicroLogix, Network DTL, PowerText, Pyramid Integrator, PanelBuilder, Pan-
elView, PLC-5/250, PLC-5/20E, PLC-5/40E, PLC-5/80E, SLC, SLC 5/01, SLC 5/02, SLC 5/03, SLC 5/
04 SLC 5/05 и SLC 500 – товарные знаки Allen-Bradley Company, Inc.
Microsoft, MS-DOS, Windows и Visual Basic - зарегистрированные товарные знаки, а Windows NT 
и Microsoft Access – товарные знаки Microsoft Corporation. 
ControlNet – товарный знак ControlNet International.
Ethernet – зарегистрированный товарный знак Digital Equipment Corporation, Intel и Xerox Corpora-
tion. IBM – зарегистрированный товарный знак International Business Machines Corporation. AIX, 
PowerPC, Power Series и RISC System/6000 - товарные знаки International Business Machines Corpo-
ration. 
UNIX – товарный знак, зарегистрированный в США и других странах, лицензируемый 
исключительно через X/Open Company Limited.
AutoCAD- зарегистрированный товарный знак Autodesk, Inc.
Все другие товарный знаки являются собственностью их владельцев и признаются здесь как 
таковые.

Гарантийное 
обязательство

Гарантия на данный  продукт Rockwell Software дается в соответствии с лицензией на продукт. На 
работу продукта влияют конфигурация системы, выполняемая прикладная программа, действия 
оператора и другие факторы. 
Реализация продукта может меняться от пользователя к пользователю.
Настоящее  руководство в максимально возможной степени отражает состояние на момент его 
издания, однако соответствующее программное обеспечение с того времени могло претерпеть 
изменения. Rockwell Software оставляет за собой право изменять любую информацию, 
содержащуюся в данном руководстве, в любой момент без предупреждения. 
Содержащиеся в настоящем руководстве инструкции не претендуют на то, чтобы учитывать все 
мелкие подробности или отличия в описываемом оборудовании, методике или процессе, а также 
определять действия при всех возможных непредвиденных ситуациях при установке, 
эксплуатации или сопровождении.

"Рокуэлл Интернэшнл ГмбХ"                                    тел. (095) 956-0464 
113054, Москва,                                    факс. (095) 956-0469 
Большой Строченовский пер. 22/25, офис 402              e-mail software@rockwell.ru



Назначение данного документа
Настоящее руководство по применению программного продукта RSNetWorxTM for 
ControlNetTM содержит информацию по его установке и перемещению по нему. В 
нем объясняется, как эффективно использовать программный продукт RSNetWorx 
for ControlNet, а также как обратиться к онлайновой справочной ситсеме и 
перемещаться по ней. 

Кому адресовано данное руководство
Мы полагаем, что вы знакомы с:
•персональными компьютерами типа IBM
•операционными системами Microsoft ®Windows® 
•коммуникационным программным продуктом RSLinxTM

Как данное руководство соотносится с другой документацией 
на этот продукт Rockwell Software

Руководство по применению RSNetWorx for ControlNet можно рассматривать как 
точку входа в комплект документации на данный продукт Rockwell Software. Этот 
комплект документации включает также онлайновую справочную систему, 
онлайновые книги, учебник по данному продукту и сообщения о выпуске новых 
версий. 
Комплект документации содержит конкретную и легкодоступную информацию по 
данному продукту. Этот комплект распространяется вместе с программным 
продуктом. Он избавит вас от утомительного перелистывания бумажных томов и 
снизит вашу информационную перегрузку. 

Онлайновая справочная система
Онлайновая справочная система содержит всю общую, справочную информацию по 
данному продукту, а также описание процедур по работе с продуктом и экранов. 
Основными элементами справочной системы являются: обзорные разделы, разделы 
по быстрому началу работы, пошаговые процедуры, разделы по определению 
причин неполадок, а также описания элементов экрана (например, текстовых окон, 
раскрывающихся списков и кнопок опций). Вся справочная система является 
зависимой от контекста приложения и обеспечивает немедленный доступ к задачам 
приложения и описаниям элементов экрана. Более подробно онлайновая справочная 
система описывается в главе «Поиск необходимой информации» данного 
руководства.
 Предисловие - i



Онлайновые книги
RSNetWorx for ControlNet снабжен функцией Online Books (онлайновые книги), 
позволяющей вам обращаться к документации по данному продукту 
непосредственно из меню Help и осуществлять поиск по этой документации. Эта 
документация включает Руководство по применению RSNetWorx for ControlNet, а 
также несколько справочников по техническим средствам в формате электронной 
книги. Вы можете скопировать эти электронные книги на ваш локальный жесткий 
диск во время инсталляции или непосредственно обращаться к ним на компакт-
диске. 

Онлайновые книги, которыми укомплектован RSNetWorx for Control-
Net, находятся в формате PDF, и их необходимо просматривать с 
помощью программы Adobe® Acrobat® Reader, находящейся на 
вашем компакт-диске с RSNetWorx for ControlNet. Вы можете 
установить Acrobat Reader  во время установки RSNetWorx for Con-
trolNet, или непосредственно обращаться к ней на компакт-диске.

Учебник
RSNetWorx for ControlNet содержит учебник по работе с данным продуктом, 
включающий общую информацию, а также конкретные задачи и примеры, которые 
помогут вам успешно работать с данным продуктом. К учебнику можно получить 
доступ через Start > Programs > Rockwell Software > RSNetWorx > RSNetWorx for 
ControlNet Tutorial.

Принятая в данном документе система обозначений
Обозначения, используемы в данном документе для пользовательского интерфейса, 
соответствуют рекомендациям Microsoft. Если вы не знакомы с пользовательским 
интерфейсом Microsoft Windows, мы рекомендуем вам ознакомиться с 
документацией на используемую вами операционную систему, прежде чем вы 
попытаетесь использовать данный программный продукт. 

Обратная связь с пользователями
Мы просим вас использовать специальную форму обратной связи с пользователями, 
приложенную к вашему программному продукту, чтобы сообщить нам об ошибках 
или о том, какую информацию, по вашему мнению, следовало бы добавит в 
следующие издания этого документа. Также вы можете направить нам свои 
замечания по продуктам и услугам фирмы Rockwell по электронной почте по адресу 
info@software.rockwell.com

Подсказка
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Глава

RSNetWorxTM for ControlNetTM - это 32-разрядная прикладная программа 
на платформе Windows® , позволяющая вам конфигурировать сети Con-
trolNet. Используя графическое или табличное представление вашей 
сети, вы можете конфигурировать параметры сети в целом, а также 
создавать расписание для всех узлов в сети, используя  Scan list Control-
Net. Также в комплект RSNetWorx for ControlNet включен инструмент 
конфигурирования Scan list (Scanlist Configuration Tool - SCT), 
отражающий специфику конкретного сканирующего устройства. Это 
средство позволяет вам определять элементы Scan list для конкретных 
процессоров, а также направлять содержимое памяти сканирующего 
устройства в сеть, а данные из сети - в память сканирующего устройства, 
находясь в  RSNetWorx for ControlNet.  
Данная глава содержит следующие разделы:
·Особенности и преимущества
·Общее представление о ControlNet
·Быстрое начало работы
·Знакомство с RSNetWorx for ControlNet
 

 - 1Введение в RSNetWorx for ControlNet



Особенности и преимущества
RSNetWorx for ControlNet имеет следующие особенности:
•Интерфейс типа "укажи и щелкни" на основе Windows, позволяющий вам легко 
конфигурировать сети ControlNet.

•Использование служб связи RSLinx, что позволяет вам в on-line режиме 
перемещаться между различными сетями, устройствами, мостами и т.д., чтобы 
выбрать сеть, которую вы хотели бы просмотреть или отредактировать.

•Возможность оптимизации вашей сети посредством конфигурирования сетевых 
параметров, таких как период обновления сети (Network Update Time - NUT) и 
максимальные запланированные или незапланированные адреса. 

•Возможность редактирования конфигураций в on-line или off-line режимах.

•Полная выгрузка/загрузка сетевой конфигурации нажатием одной кнопки. Вы 
можете выгрузить конфигурацию непосредственно из сети или загрузить 
конфигурацию в онлайновую сеть. Когда вы выгружаете или загружаете 
конфигурацию, передаются и конфигурация сети ControlNet, и Scan list для 
конкретных сканирующих устройств, а также сетевое расписание для всех 
сканирующих устройств. 

•Инструмент конфигурирования сканирующего устройства (Scanner Configuration 
Tool) конфигурирует как адреса ввода/вывода, так и одноранговых данных. 
Поддерживает целевые устройства (как для устройств Rockwell Automation, так и 
для сторонних устройств) посредством файлов электронного технического описания 
(Electronic Data Sheet - EDS) в стандарте ControlNet International.

•Интеграция с программным продуктом RSLogix5 (версия 4.0 и выше), 
позволяющая вам конфигурировать, сдавать в эксплуатацию и сопровождать 
систему на основе PLC-5C в сети ControlNet. 

•Генерирование отчетов в формате HTML.

•Комплексная контекстно-зависимая онлайновая справочная система, включающая 
дополнительную информацию и советы по определению причин проблем, 
описываемых  любым сообщением, появляющимся в области просмотра сообщений. 
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Общее представление о ControlNet
Начинать конфигурирование своей сети ControlNet вы должны с определения того, 
сколько устройств будет подсоединено к вашей сети, а также данными какого типа 
будут обмениваться эти устройства. ControlNet дает возможность обмениваться как 
запланированными, так и незапланированными данными. Алгоритмы 
диспетчеризации подробно описываются в спецификации на ControlNet International. 
Запланированная полоса пропускания обучно используется для критичных ко 
времени вводимых/выводимых данных управляющего процесса. 
Незапланированные данные обычно используются для менее критичных ко времени 
обменов данными ввода/вывода, а также для операций, связанных с конфигурацией 
(например, загрузка, выгрузка, просмотр). RSNetWorx for ControlNet позволяет вам 
вводить ваше расписание трафика и выполнять задачи, необходимые для 
распределения этого расписания по устройствам в вашей сети, таким как процессоры 
ControlLogix, процессоры ControlNet PLC, сканирующие устройства 1747, а также 
сканирующие устройства других поставщиков, соответствующие спецификации на 
ControlNet International. Периодически добавляются и другие типы устройств. 
Каждому устройству в сети ControlNet должен быть присвоен уникальный адрес. 
Присвойте адрес узла каждой рабочей станции или иному незапланированному 
устройству в сети. Для обеспечения оптимальной производительности сети эти 
адреса узлов должны начинаться с единицы и быть непрерывными. Также для 
обеспечения оптимальной производительности сети узлы, не осуществляющие 
запланированный ввод/вывод, должны иметь более высокие адреса, чем узлы, 
передающие запланированные данные ввода/вывода. 
Чтобы составить расписание для сети ControlNet, вам необходимо определиться с 
вашими требованиями по обновлению данных. Как правило, период обновления сети 
(Network Update Time - NUT) устанавливается таким, чтобы обеспечивался обмен 
данными с максимально необходимой скоростью. NUT является базовой единицей 
диспетчеризации в сети ControlNet. Он определяет периодический цикл работы сети. 
Если расписание задано корректно, каждому узлу гарантируется возможность 
передать его запланированные данные один раз за каждый период NUT. Если же 
расписание задано некорректно (за NUT должен передаваться слишком большой 
объема запланированных данных), RSNetWorx сообщит вам об этом, и вы должны 
будете  сократить объем запланированных данных и/или переопределить NUT. 
После того, как в рамках NUT будет передан весь запланированный трафик, 
передаются незапланированные данные по принципу "карусели" (кольцевого 
обслуживания) до тех пор, пока NUT не истечет. 
Также для вашей сети ControlNet вы должны задать максимальный запланированный 
адрес узла (Maximum Scheduled Node Address). Это означает наивысший адрес, с 
которого может осуществляться передача данных на отрезке NUT, предназначенном 
для запланированных (против незапланированных) данных. Помимо указания 
максимального запланированного адреса, вы также должны задать максимальный 
незапланированный адрес узла (Maximum Unscheduled Node Address). Это означает 
наивысший адрес, с которого может передаваться любая информация по сети Con-
trolNet. Эти значения вам следует ввести в свою конфигурацию с помощью закладки 
Network Parameters на страницах свойств сети (Network)  
 
Продолжая конфигурировать свою сеть, вы задаете физическую компоновку 
устройств, т.е. длину необходимого коаксиального кабеля (с округлением до 100 
метров) и/или оптоволоконного кабеля (с округлением до 100 метров). Также вы 
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должны решить, сколько репитеров и какого типа вам потребуется. Определите 
максимальный путь (с точки зрения времени задержки). Это наихудший путь 
прохождения данных по сети. После того, как вы определили этот наихудший случай 
прохождения данных, используйте закладку Media Configuration на страницах 
свойств сети (Network) программного продукта RSNetWorx for ControlNet, чтобы 
ввести параметры этого пути в ваш файл конфигурации. 
Наконец, вы заканчиваете конфигурирование заданием связей между узлами в сети. 
Для этого вы должны определить, какие данные будут потребляться каждым из 
процессоров, и в какое место таблицы данных каждого процессора будут помещаться 
эти данные. Также при желании вы можете задать, какой процессор ("сканирующее 
устройство") будет поддерживать конфигурацию для каждого адаптера. Когда вы 
определитесь с этими параметрами, используйте Scanlist Configuration Tool для ввода 
их в вашу конфигурацию для каждого из процессоров в вашей сети ControlNet. 
Для многих устройств Scanlist Configuration Tool также можно использовать для 
настройки реакции узлов или связанных с ними модулей в случае сбоя, такого как 
потеря связи с управляющим процессором. Эти параметры можно найти на странице 
свойств по закладке Configuration Settings и/или Advanced Settings  в зависимости от 
устройства или модуля, для которого вы настраиваете параметры.
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Знакомство с RSNetWorx for ControlNet
При запуске программного продукта RSNetWorx for ControlNet на экране 
появляется главное окно. В нем показывается текущая сеть (ControlNet - это 
имя файла сети по умолчанию). На иллюстрации показано главное окно и 
связанные с ним графические элементы. Каждый из графических элементов 
описывается в следующих за иллюстрацией разделах. 

Линейка
 заголовка
Линейка меню
Инструментальные    
панели
Использование
 сети

Область
 просмотра
 аппаратных
 средств

Строка 
состояния

                             Область просмотра     Область просмотра          Конфигурация сети 
                             сообщений                  избранного                       (в графическом или
                                                                                                           табличном виде)
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Линейка заголовка
В линейке заголовка содержатся иконка RSNetWorx, имя текущей конфигурации 
RSNetWorx, имя программного продукта, т.е. RSNetWorx for ControlNet, а также 
кнопки свертывания, развертывания окна и закрытия программы. 

Чтобы увидеть меню управления, щелкните по иконке RSNetWorx в линейке 
заголовка. В меню управления содержатся следующие пункты:

Пункт 
меню

Описание

Restore Восстанавливает окно до его прежних размеров после того, как 
вы увеличили его с помощью команды Maximize или свернули 
его с помощью команды Minimize.

Move Позволяет изменить положение окна на рабочем столе с 
помощью стрелок на клавиатуре. 

Size Позволяет изменить размеры окна с помощью стрелок на 
клавиатуре.

Minimize Свертывает окно до иконки, расположенной на панели задач. Эта 
команда выполняет ту же функцию, что и нажатие кнопки 
свертывания окна в линейке заголовка.  

Maximize Увеличивает окно до размеров всего экрана. Эта команда 
выполняет ту же функцию, что и нажатие кнопки развертывания 
окна в линейке заголовка.

Close Осуществляет выход из приложения RSNetWorx. Эта команда 
выполняет ту же функцию, что и нажатие кнопки Close в линейке 
заголовка.
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Линейка меню
Линейка меню главного окна содержит следующие меню:

Содержащиеся в меню опции позволяют выполнять следующие задачи:

Иконка on-line режима
Иконка on-line режима находится с правой стороны главного окна на одном уровне с 
линейкой меню. 

Эта иконка указывает на то, находится ли RSNetWorx for ControlNet в on-line режиме. 
Если вы переключите кнопку Online инструментальной панели на on-line режим, эта 
иконка «оживет». Если иконка не анимирована, RSNetWorx for ControlNet находится 
в off-line режиме. В on-line режиме RSNetWorx for ControlNet записывает 
информацию в устройства, а при сохранении – в автономный файл. В off-line режиме 
RSNetWorx for ControlNet лишь обновляет автономный файл при сохранении. 

Меню Позволяет

File Создавать, распечатывать, открывать и сохранять сетевую 
конфигурацию, генерировать отчеты или выходить из RSNetWorx 
for ControlNet 

Edit Активизировать такие действия, как вырезание, копирование и 
вставка выбранных элементов сетевой конфигурации. 

View Устанавливать и изменять интерфейсные дисплеи RSNetWorx for 
ControlNet.

Network Просматривать сеть, осуществлять переключение между on-line и 
off-line режимами, разрешать и отменять редактирование, а также 
загружать данные в сеть и выгружать их из сети.

Device Редактировать свойства выбранного устройства, шасси или модуля. 

Tools Запускать EDS Wizard.

Help Обращаться к опциями справочной системы по RSNetWorx for Con-
trolNet, связанным с ControNet техническим средствам, а также по 
другим продуктам и услугам Rockwell Software.
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8 - Руководство по применению RSNetWorx For ControlNet 

Инструментальные панели
Инструментальные панели содержат иконки для быстрого доступа к нескольким 
часто используемым функциям. Каждая кнопка инструментальной панели 
представляет собой графическое изображение команды (кроме символьной 
легенды), к которой также можно обратиться из линейки меню главного окна. 
Главное окно содержит стандартную инструментальную панель, а также панель 
специальных инструментов. 
Стандартная инструментальная панель главного окна содержит следующие 
элементы:

Иконка Пункты меню Описание

File > New Создает новую сетевую конфигурацию.

File > Open Открывает существующую сетевую 
конфигурация. Стрелочка справа от иконки 
Open обеспечивает быстрый доступ к файлам, 
которые недавно использовались. 

File > Save Сохраняет текущую сетевую конфигурацию. 

File > Print Распечатывает текущую сетевую 
конфигурацию. 

Edit > Cut Вырезает выбранное устройство из сетевой 
конфигурации и помещает его в буфер. Если 
вы вырезаете какое-либо устройство, то 
сохраняется только это устройство, но не его 
конфигурация. 

Edit > Copy Копирует выбранное устройство в буфер. 
Если вы копируете какое-либо устройство, то 
сохраняется только тип этого устройства, но 
не его конфигурация.

Edit > Paste Вставляет устройство из буфера в текущую 
сетевую конфигурацию. 

Help > What's This Переводит курсор в режим What’s This? 
справочной системы. Поместите курсор на 
элемент управления. по которому вы хотите 
получить справку, и щелкните правой 
кнопкой мыши, чтобы увидеть контекстно-
зависимую подсказку. 



Панель специальных инструментов главного окна содержит следующие элементы:

Иконка Пункты меню Описание

View > Zoom-In Увеличивает размеры изображений в текущей сетевой 
конфигурации. Имеются такие опции, как большое, 
среднее и малое увеличение. Zoom-In применяется лишь 
для графического представления.

View > Zoom-
Out

Уменьшает размеры изображений в текущей сетевой 
конфигурации. Имеются такие опции, как большое, 
среднее и малое уменьшение. Zoom-In применяется лишь 
для графического представления.

View > Hard-
ware

Выводит на экран список имеющихся аппаратных средств.

View > Favorites Выводит на экран список аппаратных средств, включенных 
вами в список избранного. 

Network > Single 
Pass Browse или 
Network > Con-
tinuous Browse

Находит все имеющиеся в данный момент времени 
устройства на основе сконфигурированных в RSLinx 
драйверов. Позволяет осуществлять однократный 
просмотр и останавливаться (один заход – single pass) или 
осуществлять непрерывный просмотр (continuous browse).

Network > On-
line

Переводит RSNetWorx for ControlNet в on-line режим. 
Чтобы перейти в off-line режим, щелкните по этой кнопке 
или вновь выберите пункты меню Network > Online. В on-
line режиме эта кнопка находится в нажатом состоянии.

View > Refresh Обновление окна. При этом графический дисплей 
реорганизуется по адресам устройств. 

Нет 
соответствующи
х пунктов меню

Выводит на экран символьную легенду, содержащую 
описания сравнительных состояний устройств. Также к 
символьной легенде можно обратиться из онлайновой 
справочной системы  путем выбора пунктов меню Help > 
Contents и выбора символьной легенды из закладки 
алфавитного указателя. 
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Область использования сети (Network Usage)
Область использования сети позволяет разрешать и отменять редактирование, а 
также показывает статистические данные, такие как текущий и ждущий обработки 
период обновления сети, а также запланированная полоса пропускания. 

Области просмотра аппаратных средств (Hardware) и избранного 
(Favorites)
Можно добавить к сетевой конфигурации устройство, выбрав его из области 
просмотра аппаратных средств (Hardware) и отбуксировав в конфигурацию 
(представленную в графическом или табличном виде). После добавления устройства 
оно будет показано в соответствующей конфигурации. В области просмотра 
избранного (Favorities) показаны все аппаратные средства, включенные в список 
избранного посредством выбора из списка аппаратных средств. Чтобы добавить 
какой-либо элемент из списка аппаратных средств в список избранного, выделите 
элемент, щелкните правой кнопкой мыши и выберите опцию Add to Favorites.
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Графическое или Табличное представление
В рабочей области данного программного средства выводится информация о 
сети в графическом или табличном виде. 
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Область просмотра сообщений (Message)
В области просмотра сообщений, находящейся в нижней части рабочей области, 
выводится журнал сообщений. Каждое сообщение состоит из трех частей:
•иконки
•32-разрядного кода сообщения
•описания сообщения

В этой области могут содержаться как сообщения об ошибках, так и 
предупредительные и/или информационные сообщения, снабженные следующими 
иконками

Иконка                    Тип сообщения

                                 Об ошибке
                     
                                 Предупредительное

 Информационное

Если вы хотите получить дополнительную информацию по 
какому-либо сообщению, вы можете выбрать соответствующее 
сообщение и нажать на клавишу F1 для получения доступа к 
онлайновой справочной системе. Вы можете показывать (Show), 
очищать (Clear), копировать (Copy) или очищать и прятать (Clear 
and Hide) сообщения,  выбрав соответствующие опции команды 
View > Messages главного меню, или щелкнув правой кнопкой 
мыши и выбрав опцию Message, находясь в области просмотра 
сообщений. 

Подсказка
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Строка состояния
В строке состояния, находящейся внизу главного окна RSNetWorx for ControlNet, 
содержится информация о состоянии программного средства. 
В левой части строки состояния выводятся информационные сообщения о работе 
программного средства RSNetWorx for ControlNet. Например, когда вы выделяете 
устройство в рабочей области программного средства, в строке состояния появляется 
краткое описание этого устройства.
В правой части строки состояния отображается текущее состояние операции 
просмотра сети, а также текущее значение коэффициента масштабирования 
(большого, среднего или малого) графического изображения. 
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Знакомство с инструментом конфигурирования Scan list 
(Scanlist Configuration Tool)

Scanlist Configuration Tool – это расширение RSNetWorx for ControlNet, позволяющее 
создавать, изменять и удалять записи о соединениях в Scan list (например, для 
процессора PLC-5). Используя Scanlist Configuration Tool, вы можете установить 
связи между устройствами и их соответствующими компонентами ввода/вывода (с 
указанием типов и размеров данных, а также временных интервалов), а затем 
отобразить эту информацию в таблицу данных. На иллюстрации показано окно Scan-
list Configuration Tool и связанные с ним графические элементы. Каждый из 
графических элементов описывается в следующих за иллюстрацией разделах. 

Линейка 
заголовка
Линейка меню
Инструментальная 
панель
Использование 
ресурсов

Настройки 
соединений

Настройки 
файлов

Сообщения

Строка 
состояния
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Линейка заголовка
В линейке заголовка содержится иконка Scanlist Configuration Tool, имя выбранного 
процессора, имя программного продукта, т.е. Scanlist Configuration, а также кнопки 
свертывания, развертывания окна и закрытия программы. 
За дополнительной информацией о линейке заголовка обращайтесь к разделу «Знакомство с 
RSNetWorx for ControlNet» данной главы. 

Линейка меню
Линейка меню Scanlist Configuration Tool содержит следующие меню:

Содержащиеся в меню опции позволяют выполнять следующие задачи:

Иконка просмотра
Иконка on-line режима находится с правой стороны главного окна  на одном уровне с 
линейкой меню. 

Эта иконка указывает на то, находится ли RSNetWorx for ControlNet в on-line режиме. Если вы 
переключите кнопку Online инструментальной панели на on-line режим, эта иконка «оживет». 
Если иконка не анимирована, RSNetWorx for ControlNet находится в off-line режиме. В on-line 
режиме RSNetWorx for ControlNet записывает информацию в устройства, а при сохранении –  
в автономный файл. В off-line режиме RSNetWorx for ControlNet лишь обновляет автономный 
файл при сохранении. 

Меню Позволяет

File Сохранять конфигурацию, генерировать отчет для данного сканирующего 
устройства или выходить из Scanlist Configuration Tool.

Edit Активизировать такие действия, как вырезание, копирование и вставка 
выбранных элементов конфигурации. 

View Устанавливать и изменять интерфейсные дисплеи Scanlist Configuration Tool.

Net-
work

Осуществлять переключение между on-line и off-line режимами, а также 
разрешать и отменять редактирование.

Device Изменять режим сканирующего устройства, например, с режима выполнения 
на режим программирования.  

Con-
nection

Добавлять устройство и привилегированные адреса.

Help Обращаться к опциями справочной системы по Scanlist Configuration Tool, а 
также по другим продуктам и услугам Rockwell Software.
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Инструментальная панель
Инструментальная панель содержит иконки для быстрого доступа к нескольким 
часто используемым функциям. Каждая кнопка инструментальной панели 
представляет собой графическое изображение команды, к которой также можно 
обратиться из линейки меню Scanlist Configuration Tool.
Инструментальная панель Scanlist Configuration Tool содержит следующие 
элементы:

Иконка Пункты меню Описание

File > Save Сохраняет текущую сетевую конфигурацию.

Edit > Cut Вырезает значение выбранного поля и помещает 
его в буфер. 

Edit > Copy Копирует значение выбранного поля в буфер.

Edit > Paste Вставляет значение поля из буфера в текущую 
сетевую конфигурацию. 

Scanlist > Auto 
Insert > All Devices

Опрашивает все устройства, которые могут 
иметь соединения в конфигурации ControlNet, и 
добавляет соединения к Scan list. 

Scanlist > Auto 
Insert > Selected 
Devices

Опрашивает выбранные устройства, которые 
могут иметь соединения в конфигурации 
ControlNet, и добавляет соединения к элементам 
таблицы отображения как элементы, ждущие 
обработки. 

Scanlist > Auto 
Address > All 
Entries

Осуществляет автоматическое отображение 
всех неотображенных адресов по всем 
элементам. 

View > Connection 
Configuration

Выводит на экран информацию по выбранному 
соединению.

View > Connection 
Status

Переключает область просмотра на показ 
состояния каждого соединения.
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Использование ресурсов (область Resourse U)
В Scanlist Configuration Tool вы также можете получить информацию по всем 
аспектам работы сети, связанным с выбранным узлом, включая использование 
памяти узла, использование сети узла, а также использование всей сети. Имея такую 
информацию, вы легко можете вносить изменения в любой Scan list и определять, как 
внесенные вами изменения влияют на работу сети ControlNet.

Элементы Scan list
Элементы Scan list позволяют вам выполнять такие задачи, как задание адресата 
соединения и добавление соединений для выбранного устройства. Для 
редактирования элементов Scan list вы должны находиться в режиме 
редактирования. 

Network > Online Переводит Scanlist Configuration Tool в on-line 
режим. Чтобы перейти в off-line режим, 
щелкните по этой кнопке или вновь выберите 
пункты меню Network > Online. В on-line 
режиме эта кнопка находится в нажатом 
состоянии.

Help > What's This Переводит курсор в режим What’s This? 
справочной системы. Поместите курсор на 
элемент управления. по которому вы хотите 
получить справку, и щелкните правой кнопкой 
мыши, чтобы увидеть контекстно-зависимую 
подсказку. 
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Настройки файлов
Настройки файлов позволяют вам задавать файлы, которые будут использоваться 
элементами Scan list для выбранного устройства. Для редактирования таких файлов 
вы должны находиться в режиме редактирования. Если вы выберете команду 
автоадресации, для вас будут выбраны необходимые файлы; в противном случае вы  
можете задать свои собственные файлы. 

Строка состояния
В строке состояния, находящейся внизу окна Scanlist Configuration Tool, содержится 
информация о состоянии программы и сканирующего устройства. 
В левой части строки состояния выводятся информационные сообщения о работе 
программы конфигурирования. Например, когда вы помещаете курсор мыши на 
какую-либо иконку инструментальной панели, в строке состояния появляется 
краткое описание этой иконки. 
В правой части строки состояния выводится следующая информация:
•On-line режим – Offline или Online 
•Режим редактирования – Monitor (наблюдение) или Edit (редактирование) 
•Тип, серия и версия процессора
•Номер узла
•Режим процессора – Remote Program (удаленное программирование), Program 
(программирование), Remote Run (удаленное выполнение) или Run (выполнение) 
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Быстрое начало работы
Самый быстрый способ, которым вы можете сконфигурировать свою сеть ControlNet 
– это позволить программному средству RSNetWorx for ControlNet просмотреть 
вашу онлайновую сеть на предмет устройств ControlNet и автоматически добавить их 
к вашей конфигурации; а затем позволить программному средству Scanlist Configu-
ration Tool автоматически сконфигурировать соединения с вашими устройствами, 
относящимися к классу адаптеров. В off-line режиме вы можете сконфигурировать 
свою сеть таким же образом, вручную перетаскивая устройства с вашей закладки 
Hardware в вашу сетевую конфигурацию. 

Для процессоров ControlLogix вам потребуется RSLogix500, чтобы 
сконфигурировать вашу сеть. Также при работе с процессорами Con-
trolLogix отсутствует off-line режим. За дополнительной 
информацией по использованию RSLogix500 и процессоров Control-
Logix обращайтесь к онлайновой справочной системе по Scanlist Con-
figuration Tool. 

В данном разделе описываются действия, которые вы должны выполнить, чтобы 
использовать программный продукт RSNetWorx for ControlNet как в on-line, так и в 
off-line режиме. Для выделения каждого основного шага и привлечения внимания к 
последовательности действий, нижеописанные шаги не включают пошаговой 
процедуры выполнения каждого действия. Когда вы будете готовы к использованию 
RSNetWorx for ControlNet, следуйте подробным процедурам, содержащимся в 
разделе Quick Start онлайновой справочной системы RSNetWorx for ControlNet. 
Для обращения к процедурам быстрого начала работы с данным программным 
продуктам выберите Help > Quick Start в главном окне RSNetWorx for ControlNet. 
Чтобы получить информацию по какому-либо элементу управления в главном окне  
или Scanlist Configuration Tool, используйте средство What’s This справочной 
системы. 

On-line режим
Шаг 1 – Создайте новую конфигурацию и осуществите поиск онлайновой сети
Первым шагом при использовании RSNetWorx for ControlNet в on-line режиме 
является создание новой конфигурации ControlNet. Как только вы создадите такую 
конфигурацию, в качестве сетевой конфигурации появится пустая сеть. 
Теперь перейдите в on-line режим и выберите коммуникационный драйвер с 
помощью утилиты просмотра ресурсов RSWho. В качестве сетевой конфигурации 
появится выбранная сеть в графическом представлении. Если вы захотите 
представить эту информацию в табличном виде вместо графического, щелкните по 
закладке Spreadsheet.

Подсказка
 - 19Введение в RSNetWorx for ControlNet



Шаг 2 – Сконфигурируйте свою сеть ControlNet и сохраните свою 
конфигурацию
После создания своей новой конфигурации и перехода в on-line режим вы должны 
сконфигурировать свою сеть ControlNet путем включения режима редактирования с 
целью получения ресурса редактирования для данной сети. Включение режима 
редактирования обеспечивает монопольный доступ для записи в файл .xc. Как только 
вы получите ресурс редактирования для данной сети, никто другой не сможет 
одновременно с вами редактировать онлайновую сеть. Редактирование свойств 
вашей сети заключается в выполнении таких действий, как ввод информации по 
конфигурации средств передачи данных, а также задание параметров сети 
(например, максимального запланированного узла и максимального 
незапланированного узла). 

В любой момент у вас может возникнуть потребность сохранить 
проделанную вами работу по конфигурированию сети. Для 
сохранения файла конфигурации (*.xc) щелкните по File > Save. 
Помните, что при сохранении вы потеряете ресурс редактирования. 
Чтобы вновь получить ресурс редактирования, щелкните по 
триггерной кнопке Edits Enabled. 

Шаг 3 – Запустите Scanlist Configuration Tool и добавьте соединение
Scanlist Configuration Tool – это программное средство, используемое для создания, 
изменения и удаления элементов Scan list в сканирующем устройстве. Также это 
средство позволяет задавать, как конкретные устройства будут сообщаться в сети. 
Используйте Scanlist Configuration Tool для конфигурирования устройств, 
содержащих внутренний Scan list, таких как процессор PLC-5. Когда вы откроете 
Scanlist Configuration Tool, вы можете либо вручную добавлять соединения с 
другими устройствами в сети, либо использовать имеющуюся в Scanlist Configuration 
Tool возможность автоматического добавления (auto insert), чтобы элементы Scan list 
добавлялись автоматически. 
Шаг 4 – Задайте адресата соединения и сохраните свое расписание
Для передачи данных от сканирующего устройства к другим устройствам в сети вы 
должны задать адресата соединения. Вы можете вручную задать адресата 
соединения для узлов сканирующего устройства в вашей сети. Последним действием 
после задания ваших адресатов соединения является сохранение расписания вашей 
конфигурации и выход из Scanlist Configuration Tool.

Off-line режим
Шаг 1 – Создайте новую конфигурацию и опишите топологию вашей сети
Первым шагом при использовании RSNetWorx for ControlNet в off-line режиме 
является создание новой конфигурации ControlNet (File > New). Когда вы создадите 
новую конфигурацию, в качестве сетевой конфигурации появится пустая сеть. 

Подсказка
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После этого включите режим редактирования для получения монопольного доступа 
для записи в файл .xc. Как только вы получите ресурс редактирования для данной 
сети, никто другой не сможет одновременно с вами редактировать автономный файл. 
В режиме редактирования вы можете описывать топологию вашей сети, дважды 
щелкая по имеющемуся устройству или перетаскивая его с закладки Hardware в 
сетевую конфигурацию. Когда вы закончите описание, в качестве сетевой 
конфигурации появится выбранная сеть в графическом представлении. Если вы 
захотите представить эту информацию в табличном виде вместо графического, 
щелкните по закладке Spreadsheet.
Шаг 2 – Сконфигурируйте вашу сеть ControlNet и устройства
После создания своей новой конфигурации вы должны сконфигурировать свою сеть 
ControlNet и устройства. Это заключается в выполнении таких действий, как ввод 
информации по конфигурации средств передачи данных, а также задание параметров 
сети (например, максимального запланированного узла и максимального 
незапланированного узла). 

В любой момент у вас может возникнуть потребность сохранить 
проделанную вами работу по конфигурированию сети. Для 
сохранения файла конфигурации (*.xc) щелкните по File > Save. 
Помните, что при сохранении вы потеряете ресурс редактирования. 
Чтобы вновь получить ресурс редактирования, щелкните по 
триггерной кнопке Edits Enabled. 

Шаг 3 – Запустите Scanlist Configuration Tool и добавьте соединение
Scanlist Configuration Tool – это программное средство, используемое для создания, 
изменения и удаления элементов Scan list в сканирующем устройстве. Также это 
средство позволяет задавать, как конкретные устройства будут сообщаться в сети. 
Используйте Scanlist Configuration Tool для конфигурирования устройств, 
содержащих внутренний Scan list, таких как процессор PLC-5. Когда вы откроете 
Scanlist Configuration Tool, вы можете либо вручную добавлять соединения для узлов 
сканирующего устройства в сети, либо использовать имеющуюся в Scanlist Configu-
ration Tool возможность автоматического добавления (auto insert), чтобы элементы 
Scan list добавлялись автоматически. 
Шаг 4 – Задайте адресата соединения и сохраните свое расписание
Для передачи данных от сканирующего устройства к другим устройствам в сети вы 
должны задать адресата соединения. Вы можете вручную задать адресата 
соединения для узлов сканирующего устройства в вашей сети. Последним действием 
после задания ваших адресатов соединения является сохранение расписания вашей 
конфигурации и выход из Scanlist Configuration Tool.
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Глава

В этой главе объясняется, как установить и запустить программный продукт 
RSNetWorx for ControlNet. Здесь приводится информация по следующим 
вопросам:
•системным требованиям
•способам инсталляции
•процедуре инсталляции
•обновлению существующей инсталляции
•процедуре запуска

Мы рекомендуем вам ознакомиться с информацией по выпуску новых версий, 
содержащейся в онлайновой справочной системе, после того, как вы 
установите этот программный продукт. В ней могут содержаться более свежие 
данные по сравнению с имевшимися на момент выпуска настоящего 
документа. Для просмотра этой информации запустите RSNetWorx for Control-
Net, а затем выберите Help > Release Notes из главного меню. 
Также перед установкой данного программного продукта мы рекомендуем вам 
ознакомиться с предустановочными замечаниями, находящимися в файле RE-
ADME на компакт-диске RSNetWorx for ControlNet. 

Если вы работаете под ОС Windows NT и вы собираетесь 
выполнить описанные в этой главе действия, у вас должны быть 
полномочия системного администратора Windows NT, а ваши 
учетные данные пользователя должны входить в 
пользовательскую группу локальных администраторов. За 
дополнительной информацией обращайтесь к своем 
системному администратору. 
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Перед тем, как начать инсталляцию
Прежде чем вы начнете инсталлировать программный продукт RSNetWorx for Con-
trolNet, вы должны быть сведущи в некоторых вопросах, таких как:
•переход от версии 1.80 к версии 2.21

•активация

Переход от версии 1.80 (или более ранней) к версии 2.21 (или более 
поздней)
Вы можете открыть конфигурации, созданные с помощью версии 1.80 (или ниже) 
RSNetWorx for ControlNet, используя версию 2.21 (или выше). Однако 
конфигурации, созданные с помощью версии 2.21 (или выше) нельзя открыть и 
сохранить, используя версию 1.80 (или ниже) RSNetWorx for ControlNet.  Новая 
разметка информации в открытой сети несовместима с предыдущими версиями. 
Если вы откроете какую-либо конфигурацию в версии 2.21 (или выше) RSNetWorx 
for ControlNet, вы не сможете вновь открыть эту конфигурацию в версии 1.80 (или 
ниже) данного продукта. 

Активация
Rockwell Software использует программный ключ для защиты программных 
продуктов на основе Windows от копирования. Каждый программный продукт имеет 
уникальный ключ. Этот ключ находится в файле активации на мастер-диске, 
поставленном вам вместе с программным продуктом. Вы можете инсталлировать 
свой программный продукт на любом количестве компьютеров, однако лицензия 
дает вам право эксплуатировать программный продукт лишь на одном компьютере 
одновременно по одной лицензии. После завершения инсталляции продукта RSNet-
Worx for ControlNet программа Setup попросит вас вставить мастер-диск RSNetWorx 
for ControlNet в дисковод. Когда вы это сделаете, утилита Move Activation перенесет 
уникальный ключ с мастер-диска RSNetWorx for ControlNet на ваш жесткий диск. 
Если впоследствии вы захотите переместить активацию на другой диск или просто 
удалить ее, вам придется переместить ключ обратно на мастер-диск. За 
дополнительной информацией о перемещении программных ключей, защите от 
копирования и активации программного продукта обращайтесь к Приложению А. 

Инсталляция, удаление или обновление данного программного 
продукта не влияют на активацию, если только вы не получаете 
приглашение переместить активацию. 

Подсказка
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Системные требования
Для эффективного использования RSNetWorx for ControlNet ваш персональный 
компьютер должен удовлетворять следующим требованиям к аппаратным средствам 
и программному обеспечению:

Требования к аппаратным средствам
•микропроцессор Intel PentiumTM

•32 Мб RAM;  для больших сетей требуется больший объем памяти
•31 Мб свободного дискового пространства; для установки всех имеющихся опций 
рекомендуется 62 Мб
•дисковод для компакт-дисков
•дисковод для 3,5-дюймовых дискет емкостью 1,44 Мб
•16-цветный графический адаптер VGA (разрешение 640 х 480)
•рекомендуется мышь или другое позиционирующее устройство

Требования к программному обеспечению
Для использования RSNetWorx for ControlNet ваш соответствующий стандартам 
IBM персональный компьютер должен удовлетворять следующим требованиям к 
программному обеспечению:

Программа инсталляции обнаружит, требуется ли обновление 
компонентов операционной системы, и при необходимости 
автоматически исполнит эти компоненты. Некоторые компоненты 
программного обеспечения сторонних поставщиков укажут на 
необходимость перезагрузки вашей системы; однако мы 
рекомендуем перегружать систему тогда, когда об этом попросит 
программный пакет инсталляции. 

•RSNetWorx for ControlNet может использоваться с операционными системами 
Microsoft Windows NT 4.0 (Service Pack 3 или выше), Microsoft Windows 95, Micro-
soft Windows 98 и Microsoft Windows 2000.

На момент выпуска данного руководства RSNetWorx for ControlNet 
был протестирован с предназначенной для выпуска версией 
операционной системы Microsoft Windows 2000.

Вы должны помнить следующее о каждой из операционных систем:
RSNetWorx for ControlNet не будет работать под более ранними версиями Microsoft 
Windows NT, а также под Windows NT без указанных пакетов обновления (Service 
Packs).

Подсказка
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Если вы используете Microsoft Windows 95, в вашей системе должна быть 
инсталлирована утилита DCOM for Windows 95 от Microsoft. Программа 
инсталляции автоматически инсталлирует для вас эту утилиту. 
•Если вы используете Microsoft Windows 98, у вас должны быть Harmony Services от 
Rockwell Software.
•RSLinx Lite 2.10 Service Pack 2a (2.10.176) или выше для использования RSNetWorx 
for ControlNet в on-line режиме.
•RSLogix 5 (версия 4.0 или выше).

Инсталляция программного продукта RSNetWorx for ControlNet
Вы можете инсталлировать один или несколько программных продуктов Rockwell 
Software на один и тот же компьютер. Выберите для инсталляции требуемый продукт 
Rockwell Software и каждый необходимый компонент. 

При инсталляции RSNetWorx for ControlNet у вас будет возможность 
задать директорию. Предлагаемой директорией по умолчанию является 
следующая:

x:\Program Files\Rockwell Software\RSNetWorxII

Мы рекомендуем вам использовать директорию по умолчанию всегда, 
когда это возможно. Эта поддиректория содержит все файлы 
приложения, необходимые для работы соответствующего программного 
продукта. 
В описанных в настоящем документе процедурах полагается, что 
используется имя по умолчанию. Если вы отказались от использования 
имени по умолчанию, замените его на фактически используемое вами 
имя. 

Для инсталляции программного продукта RSNetWorx for ControlNet выполните 
следующую последовательность действий:
1. Запустите свою операционную систему, если она не запускается автоматически.
2. Вставьте компакт-диск RSNetWorx for ControlNet в соответствующий дисковод.

Если 
автозапуск:

То:

включен Программа инсталляции запустится автоматически и появится 
диалоговое окно выбора. Перейдите к шагу 3. 

Подсказка
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3.  Следуйте появляющимся на экране инструкциям для инсталляции RSNetWorx for 
ControlNet и других необходимых программных пакетов. 

4.  По окончании инсталляции программного обеспечения выньте компакт-диск 
RSNetWorx for ControlNet и мастер-диск из соответствующих дисководов. 
Обеспечьте сохранность этих дисков.  

Инсталляция клиентской копии с выделенного сервера
Будучи клиентом по отношению к инсталляции клиент-сервер, вы можете 
инсталлировать один или несколько продуктов Rockwell Software с выделенного 
сервера на машину конечного пользователя. Для инсталляции программного 
продукта RSNetWorx for ControlNet с сервера выполните следующие действия:
1.  Обозначьте выделенный сервер, предоставленный вашим системным 
администратором, как сетевой диск. Системный администратор должен был 
предварительно скопировать все содержимое компакт-диска и назначить файлам  
доступ лишь для чтения и выполнения. Инсталлирующий программное 
обеспечение пользователь не должен иметь доступа для записи в файлы. 

2.  Дважды щелкните по autorun.exe в клиентской директории инсталляции.
3.  Дальнейшие действия описаны в разделе «Инсталляция программного продукта 

RSNetWorx for ControlNet» данной главы.

отключен Выполните следующие действия:
• Щелкните по Start, затем по Run. Появится диалоговое окно 

Run.
• В поле Open введите x:\autorun, где х соответствует 
дисководу, содержащему компакт-диск RSNetWorx for Control-
Net. 

• Щелкните по OK. Появится диалоговое окно выбора.
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Обновление существующей инсталляции
Для обновления существующей инсталляции с целью получения более новой версии 
выполните следующую последовательность действий:
1.  Выберите Settings (Настройка) > Control Panel (Панель управления) из меню Start 

(Пуск).
2.  Дважды щелкните по иконке Add/Remove Programs (Добавление/Удаление 
программ), выберите из списка RSNetWorx for ControlNet и щелкните по Add/Re-
move. Щелкните по OK, чтобы закрыть диалоговое окно Add/Remove Programs. 

3.  Вставьте компакт-диск RSNetWorx for ControlNet в соответствующий дисковод. 

4.  Следуйте появляющимся на экране инструкциям. За дополнительной 
информацией обращайтесь к разделу «Инсталляция программного продукта 
RSNetWorx for ControlNet» данной главы.

Если активация уже была установлена ранее, нет необходимости 
переносить активацию. Если активация не была инсталлирована, 
вставьте мастер-диск в 3,5-дюймовый дисковод и следуйте 
появляющимся на экране инструкциям. За дополнительной 
информацией по активации обращайтесь к Приложению А. 

Если 
автозапуск:

То:

включен Программа инсталляции запустится автоматически и появится 
диалоговое окно выбора. Перейдите к шагу 4. 

отключен Выполните следующие действия:
• Щелкните по Start, затем по Run. Появится диалоговое окно 

Run.
• В поле Open введите x:\autorun, где х соответствует 
дисководу, содержащему компакт-диск RSNetWorx for Control-
Net. 

• Щелкните по OK. Появится диалоговое окно выбора.

Подсказка
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Запуск программного продукта RSNetWorx for ControlNet
Чтобы запустить продукт RSNetWorx for ControlNet, щелкните по Start (Пуск), затем 
выберите Programs (Программы) > Rockwell Software > RSNetWorx (папка) > 
RSNetWorx for ControlNet (выполняемый файл) из меню Start (Пуск).

Чтобы создать иконку на рабочем столе, щелкните по Start, затем выберите Pro-
grams  > Rockwell Software  > RSNetWorx for ControlNet shortcuts и перетащите 
иконку быстрого доступа к RSNetWorx for ControlNet в любое место по вашему 
желанию. 

Мы исходим из предположения. что вы используете имена по 
умолчанию для директории и группы программ. Если на самом деле 
вы не используете имена по умолчанию, замените указанные имена 
по умолчанию на действительно используемые вами имена. 

Возможные причины проблем с инсталляцией
Если RSNetWorx for ControlNet не запускается или не работает должным образом, 
рассмотрите следующие возможные причины:
•Правильная ли версия RSLinx у вас установлена? Для RSNetWorx for ControlNet 
требуется RSLinx Lite 2.1 Service Pack 1 (2.10.167) или более поздняя версия.

•Достаточный ли объем памяти у вашего компьютера? Для работы RSNetWorx for 
ControlNet под Microsoft Windows 95, Microsoft Windows NT или Microsoft Windows 
98 требуется как минимум 32 Мб RAM.

•Не переустановили ли вы Service Pack более ранней версии, или не удалили ли вы 
какой-либо компонент, например, DCOM, необходимый для RSNetWorx for Control-
Net? 

•Обратились ли вы к службе сопровождения RSNetWorx в Интернете за 
информацией по определению причин проблем с работой программного продукта? 
Войдите на http://support.software.rockwell.com, щелкните по Support Library, а затем 
найдите Tech Notes on RSNetWorx for ControlNet.

Подсказка
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Глава

В этой главе рассказывается о том, как использовать:
•устройства с EDS

•редактор экземпляра класса (Class Instance Editor)

•сети ControlNet в отличие от сетей Remote I/O и DH+

•интеграцию RSLogix 5 с RSNetWorx

Устройства с EDS
Конфигурация связей устройств ControlNet основывается на электронном 
техническом описании (electronic data sheet – EDS). Электронное техническое 
описание представляет собой файл ASCII, подготовленный производителем и 
поставляемый вместе с соответствующим устройством.  
Как только файл EDS для устройства, которое вы хотите сконфигурировать, будет 
зарегистрирован в системе RSNetWorx for ControlNet, вы сможете сконфигурировать 
свойства (атрибуты) устройства, а также способ сообщения между этим устройством 
и другими устройствами в сети ControlNet. Хотя процедура конфигурирования 
устройства в принципе одинакова для всех устройств, каждое устройство обладает 
уникальным набором свойств. 

Библиотека EDS
Библиотека электронных технических описаний (EDS) представляет собой собрание 
файлов EDS, зарегистрированных в RSNetWorx for ControlNet. Файлы EDS, 
предоставляемые производителями устройств, содержат конфигурационную и 
идентификационную информацию для соответствующих устройств. 
Продукт RSNetWorx for ControlNet может обращаться только к зарегистрированным 
устройствам. Для регистрации файлов EDS для неизвестного устройства, а также для 
инсталляции после обновления файлов EDS необходимо использовать мастера 
регистрации EDS (EDS Registry Wizard).
Хотя с продуктом RSNetWorx for ControlNet вы получите большое количество 
файлов EDS, в какой-то момент вам могут понадобиться дополнительные файлы 
электронного технического описания. Эти файлы можно получить следующими 
способами:
•взяв с дистрибутивных дискет, распространяемых в комплекте с устройствами
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•выгрузив с web-сайта ControlNet International – http://www.controlnet.org

•выгрузив с сайта производителя. Например, для устройств Rockwell Automation это 
сайт http://www.ab.com/networks/eds (сайт технической поддержки Allen-Bradley)

Class Instance Editor (редактор экземпляра класса)
Class Instance Editor – это инструмент, позволяющий вам направлять данные в 
устройство ControlNet, которое невозможно сконфигурировать в RSNetWorx for Con-
trolNet иным образом. С помощью Class Instance Editor вы можете либо вводить 
исходные данные и загружать их в устройство, либо считывать данные с устройства. 

Мы не советуем вам конфигурировать устройства с помощью Class 
Instance Editor, если вы не получили соответствующих указаний от 
персонала службы технической поддержки данного программного 
продукта. 

Для использования данного редактора вам необходимо знать, как адресовать 
сервисные программы, классы, экземпляры и атрибуты с помощью 
соответствующих шестнадцатеричных кодов в устройстве. Эту информацию можно 
получить только у производителя устройства. Она будет использоваться лишь при 
работе с представителями службы технической поддержки данного аппаратного 
устройства. Также вам нужно будет знать, как адресовать сервисные программы 
внутри устройства. Эта информация должна содержаться в прилагаемом к 
устройству техническом описании (проспекте). В общем случае адрес состоит из 
четырех частей. 
После того, как вы адресовали устройство, вы должны сконфигурировать параметры 
с помощью шестнадцатеричных сервисных программ. Эта информация также 
должна содержаться в прилагаемом к устройству техническом описании. 
За дополнительной информацией о конфигурировании устройства с помощью Class 
Instance Editor обращайтесь в службу технической поддержки Rockwell Software.

Внимание!
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ControlNet в отличие от сетей Remote I/O и DH+
Поскольку ControlNet объединяет в себе функциональные возможности сети ввода-
вывода и информационной сети, можно использовать ControlNet  вместо сочетания 
сетей Remote I/O и DH+ или Remote I/O и Ethernet. Однако вам следует помнить о 
следующих моментах при проектировании своей архитектуры. 
•   Сеть ControlNet спроектирована оптимальным образом для предсказуемой многократной 
передачи запланированных данных (аналогично сети Remote I/O). Также эта схема 
обеспечивает передачу незапланированных данных, аналогично сети DH+, но затрудняет 
прогнозирование скорости передачи незапланированных данных. 

•   ControlNet и Ethernet не являются эквивалентными сетями и имеют разное назначение. 
При правильном использовании эти сети дополняют друг друга, а не конкурируют друг с 
другом. Поэтому имейте ввиду, что если вы используете ControlNet для приложений с 
преобладающим или большим незапланированным трафиком, вы можете использовать ее 
не по назначению. 

•   Передача данных по сети Ethernet основана на принципе «первым пришел, первым 
обслужен». Поэтому в мало загруженной сети Ethernet передача конкретного сообщения 
может быть осуществлена быстрее, чем в ControlNet. Также, для сравнения, одно 
сообщение Ethernet максимального размера (750 слов) может быть заменено максимум 
семью незапланированными сообщениями ControlNet.

•   Как правило, если вы предполагаете использовать небольшие незапланированные пакеты, 
содержащие менее 100 слов, и не планируете иметь большой незапланированный сетевой 
трафик, вы можете использовать для обмена незапланированными сообщениями Control-
Net или Ethernet, при этом скорость передачи данных будет сравнимой. Если вы 
предполагаете использовать пакеты большего размера и большой трафик, то вам следует 
использовать сеть Ethernet. 

•   Реализация обмена незапланированными сообщениями ControlNet 1.5  в процессоре PLC-
5/C15 имитирует обмен сообщениями по команде передачи сообщений 
программируемого контроллера (Programmable Controller Communication Command – 
PCCC) и, таким образом, поддерживает не более 128 слов в одном пакете сообщений 
(против макисмально допустимых 255 слов). В результате процессор PLC-5/C15 должен 
работать в два раза интенсивнее для отправки/получения незапланированных сообщений 
по ControlNet.

•   Ограничения по буферам определяются конкретным устройством и могут влиять на 
общее количество сообщений, обрабатываемых данным устройством, что влияет на 
общую производительность. В нижеследующей таблице приводятся данные по 
имеющимся буферам для обмена незапланированными сообщениями с установленным 
соединением и без установленного соединения для конкретных продуктов. 

Продукт: С установленным 
соединением:

Без установленного 
соединения:

Процессор PLC-5/C 32 20

Модуль 1784-KTCx 25 20

Модуль 1756-CNB 64* 20/5**
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*Это не фиксированное значение; оно определяется периодом обновления сети 
(NUT).
**Максимальное значение 5 соответствует версиям встроенного программного 
обеспечения модуля ниже А01.19, а 20 – версии А01.19 и выше. 
По своей природе, сообщения с установленным соединением требуют 
использования буферов в течение более длительных интервалов времени, чем 
сообщения без установленного соединения, поскольку соединение – а 
соответственно, и буфер – продолжает использоваться до окончания связи. 
Напротив, в случае сообщений без установленного соединения, соединение и 
соответствующий буфер используются лишь в течение короткого времени. 

Интеграция RSLogix 5 с RSNetWorx 
Интеграция RSLogix 5 с RSNetWorx: on-line режим без использования Re-
mote I/O (RIO) Allen-Bradley
Для оперативного и эффективного использования RSNetWorx for ControlNet и 
RSLogix 5 в on-line режиме при отсутствии Remote I/O Allen-Bradley выполните 
следующие действия:

Действия приводятся исходя из предположения, что вы уже 
сконфигурировали драйвер связи с помощью RSLinx для сообщения 
со своей сетью ControlNet. 

Задайте компоновку сети
1.  Задайте компоновку аппаратных средств вашей сети ControlNet  в RSNetWorx for 

ControlNet. Выполните следующее:
а.   Запустите главное окно RSNetWorx for ControlNet и выберите Network > 

Online.
б.  В диалоговом окне Browse for Network выберите путь связи с вашей сетью 

ControlNet, затем щелкните по OK. Дождитесь, пока закончится 
выполнение операции просмотра, прежде чем переходить к шагу 1в.

в.  Щелкните по триггерной кнопке Edits Enabled.

Если появится диалоговое окно Online/Offline Mismatch, 
выберите опцию “use offline data (download)”.

Подсказка

Подсказка
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Добавьте соединения
2.  Задайте в RSNetWorx for ControlNet соединения, необходимые PLC-5C для   
сообщения по сети ControlNet. Для этого выполните следующее:
а.  Щелкните по процессору PLC-5C в сетевой конфигурации, а затем выберите 

Device > Scanlist Configuration.  RSNetWorx for ControlNet  запустит  Scanlist 
Configuration Tool  и выведет на экран Scan list для выбранного процессора 
PLC-5C. 

     PLC-5C, который вы конфигурируете в данный момент, выделяется зеленым 
цветом. Кроме того, в линейке заголовка выводится имя этого PLC-5C. 

б.  Щелкните по устройству, с которым вы хотите установить соединение, а затем 
выберите Connection > Insert. В диалоговом окне Connection Properties задайте 
все атрибуты конфигурации ControlNet, связанные с данным соединением. По 
завершении щелкните по OK.

     Повторите эти действия для каждого устройства в сети ControlNet, к которому 
вы хотите подключиться. 

Вы можете установить соединения по умолчанию со всеми 
устройствами в сети ControlNet или с выбранным набором 
устройств в сети ControlNet. Выберите Connection > Auto In-
sert > All Devices, чтобы провести поиск по всем устройствам в 
данной конфигурации и добавить недостающее соединение. 
Выберите Connection > Auto Address > All Entries, чтобы 
система смогла выбрать очередной несконфигурированный 
адрес из имеющихся и определить связанные с ControlNet 
файлы (например, статуса, конфигурации, входных данных и 
выходных данных), необходимые для каждого соединения. 

3. Повторите шаг 2 для каждого PLC-5C в вашей сети ControlNet.

Имейте ввиду, что для каждого PLC-5C в вашей сети ControlNet, 
который вы активно редактируете, будет запущено отдельное окно 
Scanlist Configuration Tool. 

4.  Чтобы сохранить выполненную вами работу в конфигурационном файле Control-
Net (*.xc), выберите File > Save в главном окне. Впоследствии вы привяжете 
конкретные файлы проекта RSLogix 5 (.rsp) к этому файлу. 

     По завершении сверните каждое окно Scanlist Configuration Tool. После этого 
сверните главное окно.

Подсказка
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Привяжите файл проекта RSLogix 5 (*.rsp) к каждому узлу PLC-5C в 
конфигурационном файле ControlNet (*.xc) и задайте информацию по 
конфигурации модуля

5.  В RSLogix 5 создайте новый проект для процессора PLC-5C и привяжите этот 
проект к конфигурационному файлу (*.xc), созданному в RSNetWorx for Control-
Net. Выполните следующее:
а.  Запустите RSLogix 5, затем выберите Comms > Who Active Go Online.
б.  В диалоговом окне Communications выберите процессорный узел PLC-5C, 
затем щелкните по OK.

в.  В диалоговом окне Default Program Rename  введите имя для выбранного 
процессора PLC-5C, затем щелкните по OK. Образ процессора будет загружен 
в файл проекта RSLogix 5 (*.rsp).

Если у PLC-5C уже есть имя, на экране появится диалоговое 
окно Going to Online. Щелкните по Create New File. 

В дереве управления проекта выберите иконку Controller Properties. Щелкните 
правой кнопкой мыши и выберите Open.В диалоговом окне Controller Proper-
ties просмотрите ваш компьютер, чтобы найти конфигурационный файл Con-
trolNet (*.xc), который вы создали на шаге 2 и 3. Кроме того, не забудьте 
указать адрес узла, по которому в вашей сети ControlNet находится выбранный 
PLC-5C, после чего щелкните по OK. 

Необязательно вводить какое-либо значение в поле ControlNet 
Source Link ID. За дополнительной информацией о поле Con-
trolNet Source Link ID обращайтесь к интерактивной 
справочной системе RSLogix 5.

6.  Сконфигурируйте каждый модуль и сохраните данные по конфигурации в таблице 
данных процессора. Чтобы определить эти ячейки в RSLogix5, выполните 
следующее:
а.  В дереве управления проектом выберите иконку I/O Configuration. Щелкните 
правой кнопкой мыши и выберите Open. В диалоговом окне I/O Configuration 
– Chassis Table показаны все устройства, с которыми сообщается данный 
процессор, а также соответствующая информация по отображению ввода-
вывода. 
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б.  Выберите шасси, содержащее модуль, который вы хотите сконфигурировать в 
сети ControlNet. Щелкните правой кнопкой мыши и выберите Display Chassis. 
RSNetWorx for ControlNet автоматически добавит и покажет каждый из 
модулей в этом шасси, с которыми сообщается данный PLC-5C. 

в.  Выберите тип модуля в данном шасси, который вы хотите сконфигурировать. 
Щелкните правой кнопкой мыши и выберите Display Module. В диалоговом 
окне Module Configuration для выбранного модуля сконфигурируйте модуль 
для вашего приложения. По завершении щелкните по Accept Edits, затем по 
Close. Закройте соответствующие диалоговые окна. 

     Повторите эти действия для всех модулей в данном шасси, к которым это 
применимо. 

г.  Щелкните по OK в ответ на приглашение загрузить конфигурацию модуля. 
7.  Введите  соответствующую релейную логику для процессора PLC-5C.
8.  Сохраните файл проекта RSLogix (*.rsp) для процессора PLC-5C. Щелкните по 

Yes в ответ на приглашение выгрузить текущие значения таблицы данных. На 
этом этапе соответствующие изменения фиксируются в указанном файле проекта 
RSLogix 5, а все ждущее обработки редактирование включается в связанный с 
ним файл .xc.

     По завершении закройте файл проекта RSLogix 5.
9.  Повторите шаги с 5 по 8 для каждого процессора PLC-5C в вашей сети ControlNet. 

Обязательно задайте уникальный номер узла ControlNet для 
каждого процессора PLC-5C в вашей сети ControlNet.
 

По завершении сверните RSLogix 5.
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Добавьте редакционные изменения, внесенные в RSLogix 5
10.Находясь в RSNetWorx for ControlNet, включите изменения для каждого PLC-5C 
в сети, сделанные в RSLogix 5, в конфигурационный файл (*.xc), созданный в 
шагах с 1 по 3. Выполните следующее:
а.  Разверните главное окно RSNetWorx for ControlNet и включите триггерную 
кнопку Edits Enabled. Все изменения, сделанные в RSLogix 5, автоматически 
перейдут в категорию ждущих обработки. 

В каждом окне Scanlist Configuration Tool вы можете увидеть 
изменения, внесенные в модули в RSLogix 5. Эти изменения 
будут показаны текстом синего цвета (ждущие обработки 
редакционные изменения). 

б.  В главном окне (или любом окне Scanlist Configuration Tool) выберите File > 
Save, чтобы включить все ждущие обработки изменения, внесенные в RSLogix 
5, в соответствующий файл *.xc. В диалоговом окне Save configuration 
выберите нужную опцию сохранения и щелкните по OK.

в.  Сверните все окна Scanlist Configuration Tool.
     Теперь конфигурирование вашей системы завершено.
Синхронизируйте файл проекта RSLogix 5 (*.rsp) с интерактивным PLC-5C

11.Находясь в RSLogix 5, откройте каждый файл проекта (*.rsp), созданный для 
каждого узла PLC-5C в вашей сети. Выполните следующее: 
а.  Откройте файл проекта RSLogix 5 (*.rsp).
б.  Выберите Comms > Upload, чтобы сохранить конфигурацию сети в 
конфигурационном файле ControlNet (*.xc). Ваша офлайновая сеть должна 
соответствовать вашей онлайновой сети. 

в.  Выберите Comms > Go Online.

Если вы получили приглашение сохранить изменения, 
щелкните по Yes. 

г.  Выберите режим Remote Run.
12.Повторите эти действия для каждого файла проекта RSLogix 5 (*.rsp). По 
завершении RSLogix 5 и RSNetWorx for ControlNet будут синхронизированы. 

Чтобы получить дополнительную информацию об интеграции RSLogix 5 и RSNet-
Worx for ControlNet, обратитесь к автофаксу Rockwell Software по номеру 440-646-
7777 и запросите документ 300347.  
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Интеграция RSLogix 5 с RSNetWorx: автономный режим (off-line) 
без использования Remote I/O (RIO) Allen-Bradley
Для оперативного и эффективного использования RSNetWorx for ControlNet и 
RSLogix 5 в режиме off-line, когда можно не принимать во внимание Remote I/O Al-
len-Bradley, и последующей передачи соответствующей информации в вашу 
интерактивную сеть выполните следующие действия:

Действия приводятся исходя из предположения, что вы уже 
сконфигурировали драйвер связи с помощью RSLinx для сообщения 
со своей сетью ControlNet. 

Задайте компоновку сети
1.  Задайте компоновку аппаратных средств вашей сети ControlNet  в RSNetWorx for 

ControlNet. Выполните следующее:
а.  Запустите главное окно RSNetWorx for ControlNet и щелкните по триггерной 
кнопке Edits Enabled. 

б.  В окне просмотра Hardware выберите одно из устройств вашей сети ControlNet 
(например, PLC-5C или адаптерный модуль) и перетащите его в область 
конфигурации сети (в графическом или табличном представлении). RSNet-
Worx for ControlNet автоматически присвоит этому устройству очередной из 
имеющихся номеров узла, если он окажется неприемлемым для вашего 
приложения, соответственно измените номер узла. 

     Повторите эти действия для каждого устройства в вашей сети ControlNet.
в.  Щелкните по адаптерному модулю в сетевой конфигурации и задайте 
содержимое шасси, выбрав Device > Define Chassis. В диалоговом окне Define 
Chassis добавьте к данному шасси соответствующие модули для обеспечения 
соответствия с реальным оборудованием, имеющимся в вашей сети. По 
завершении щелкните по OK. 

     Повторите для каждого адаптерного модуля в вашей сети ControlNet.
     Задайте информацию по локальному рэку и добавьте соединения

2.  Задайте в главном окне информацию по локальному рэку и установите 
соединения, необходимые PLC-5C для сообщения по сети ControlNet. Для этого 
выполните следующее:
а.  Щелкните по процессору PLC-5C в сетевой конфигурации, а затем выберите 

Device > Scanlist Configuration.  RSNetWorx for ControlNet  запустит окно 
Scanlist Configuration Tool  и выведет на экран Scan list для выбранного 
процессора PLC-5C. 
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     PLC-5C, который вы конфигурируете в данный момент, выделяется зеленым 
цветом. Кроме того, в линейке заголовка выводится имя этого PLC-5C. 

б.  Щелкните по Device > I/O File Allocation. Задайте информацию по вашему 
локальному рэку, затем щелкните по OK.

в.  Щелкните по устройству, с которым вы хотите установить соединение, а затем 
выберите Connection > Insert. В диалоговом окне Connection Properties задайте 
все атрибуты конфигурации ControlNet, связанные с данным соединением. По 
завершении щелкните по OK.

     Повторите эти действия для каждого устройства в сети ControlNet, к которому 
вы хотите подключиться. 

Вы можете установить соединения по умолчанию со всеми 
устройствами в сети ControlNet или с выбранным набором 
устройств в сети ControlNet. Выберите Connection > Auto In-
sert > All Devices, чтобы провести поиск по всем устройствам в 
данной конфигурации и добавить недостающее соединение. 
Выберите Connection > Auto Address > All Entries, чтобы 
система смогла выбрать очередной несконфигурированный 
адрес из имеющихся и определить связанные с ControlNet 
файлы (например, статуса, конфигурации, входных данных и 
выходных данных), необходимые для каждого соединения. 

3.  Повторите шаг 2 для каждого PLC-5C в вашей сети ControlNet.

Имейте ввиду, что для каждого PLC-5C в вашей сети ControlNet, 
который вы активно редактируете, будет запущено отдельное окно 
Scanlist Configuration Tool. 

4.  Чтобы сохранить выполненную вами работу в конфигурационном файле Control-
Net (*.xc), выберите File > Save в главном окне. Впоследствии вы привяжете 
конкретные файлы проекта RSLogix 5 (.rsp) к этому файлу. 

     По завершении сверните каждое окно Scanlist Configuration Tool. После этого 
сверните главное окно. 

Привяжите файл проекта RSLogix 5 (*.rsp) к каждому узлу PLC-5C в 
конфигурационном файле ControlNet (*.xc) и задайте информацию по 
конфигурации модуля
5.  В RSLogix 5 создайте новый проект для процессора PLC-5C и привяжите этот 
проект к конфигурационному файлу (*.xc), созданному в RSNetWorx for Control-
Net. Выполните следующее:
а.  Запустите RSLogix 5. 
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б.  Откройте новый файл проекта, выбрав File > New. В диалоговом окне Select 
Processor Type укажите соответствующую платформу (ControNet), процессор 
PLC-5C (включая серию и версию), имя процессора, драйвер связи, а также 
номер узла для процессора PLC-5C в вашей сети ControlNet. Щелкните по OK.

Для работы с сетью ControlNet вы должны указать один из 
процессоров PLC-5C, за которым должен следовать суффикс 1.5 
(например, PLC-5/40C 1.5). 

в.  В диалоговом окне Select ControlNet Project просмотрите свой компьютер, 
чтобы найти файл конфигурации ControlNet (*.xc), который вы создали в шагах 
2 и 3. Кроме этого, укажите адрес узла, по которому указанный процессор PLC-
5C находится в вашей сети ControlNet, а затем щелкните по OK.

6.  Сконфигурируйте каждый модуль и сохраните данные по конфигурации в таблице 
данных процессора. Чтобы определить эти ячейки в RSLogix5, выполните 
следующее:
а.  В дереве управления проектом выберите иконку I/O Configuration. Щелкните 
правой кнопкой мыши и выберите Open. В диалоговом окне I/O Configuration 
– Chassis Table показаны все устройства, с которыми сообщается данный 
процессор, а также соответствующая информация по отображению ввода-
вывода. 

б.  Выберите шасси, содержащее модуль, который вы хотите сконфигурировать в 
сети ControlNet. Щелкните правой кнопкой мыши и выберите Display Chassis. 
RSNetWorx for ControlNet автоматически добавит и покажет каждый из 
модулей в этом шасси, с которыми сообщается данный PLC-5C. 

в.  Выберите тип модуля в данном шасси, который вы хотите сконфигурировать. 
Щелкните правой кнопкой мыши и выберите Display Module. В диалоговом 
окне Module Configuration для выбранного модуля сконфигурируйте модуль 
для вашего приложения. По завершении щелкните по Accept Edits, затем по 
Close. Закройте соответствующие диалоговые окна. 

     Повторите эти действия для всех модулей в данном шасси, к которым это 
применимо. 

7.  Введите  соответствующую релейную логику для данного процессора PLC-5C.
8.  Сохраните файл проекта RSLogix (*.rsp) для данного процессора PLC-5C. На этом 
этапе соответствующие изменения фиксируются в указанном файле проекта 
RSLogix 5, а все ждущее обработки редактирование включается в связанный с 
ним файл .xc.

     Закройте файл проекта RSLogix 5.
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9.  Повторите шаги с 5 по 8 для каждого процессора PLC-5C в вашей сети ControlNet. 

Обязательно задайте уникальный номер узла ControlNet для каждого 
процессора PLC-5C в вашей сети ControlNet.

     По завершении сверните RSLogix 5.
Добавьте редакционные изменения, внесенные в RSLogix 5
10.Находясь в RSNetWorx for ControlNet, включите изменения для каждого PLC-5C 
в сети, сделанные в RSLogix 5, в конфигурационный файл (*.xc), созданный в 
шагах с 1 по 3. Выполните следующее:
а.  Разверните главное окно RSNetWorx for ControlNet и включите триггерную 
кнопку Edits Enabled. Все изменения, сделанные в RSLogix 5, автоматически 
перейдут в категорию ждущих обработки. 

В каждом окне Scanlist Configuration Tool вы можете увидеть 
изменения, внесенные в модули в RSLogix 5. Эти изменения 
будут показаны текстом синего цвета (ждущие обработки 
редакционные изменения). 

б.  В главном окне (или любом окне Scanlist Configuration Tool) выберите File > 
Save, чтобы включить все ждущие обработки изменения, внесенные в RSLogix 
5, в соответствующий файл *.xc. В диалоговом окне Save configuration 
выберите нужную опцию сохранения и щелкните по OK.

в.  Сверните все окна Scanlist Configuration Tool.
     Теперь конфигурирование вашей системы завершено.
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Загрузите файл конфигурации ControlNet (*xc), содержащий Scan list PLC-5C
11.Подключитесь к интерактивной сети ControlNet и загрузите объединенный 
конфигурационный файл (*.xc). Выполните следующее:
а.  Выберите Network > Online. В диалоговом окне Network Browse выберите сеть 

ControlNet, в которую вы хотите загрузить объединенный конфигурационный 
файл (*.xc). Щелкните по OK.

Если появится диалоговое окно Online/Offline Mismatch, укажите, 
что вы хотите использовать офлайновую информацию, и загрузите 
ее в сеть. Щелкните по OK.

     Если диалоговое окно Online/Offline Mismatch не появится, выберите Network 
> Download. 

б.  Закройте главное окно. Каждое из окон Scanlist Configuration Tool закроется 
автоматически. 

Загрузите и синхронизируйте файл проекта RSLogix 5 (*.rsp) с интерактивным 
PLC-5C
12.Находясь в RSLogix 5, откройте каждый файл проекта (*.rsp), созданный для 
каждого узла PLC-5C в вашей сети. Выполните следующее: 
а.  Выберите Comms > System Comms. В диалоговом окне Communications 
выберите соответствующий узел, после чего щелкните по Download. Появится 
приглашение продолжить загрузку; щелкните по Yes.

б.  Появится приглашение сохранить существующую интерактивную 
конфигурацию; щелкните по Yes. Появится приглашение продолжить 
загрузку; щелкните по Yes.

в.  В диалоговом окне Save Program As вы получите приглашение сохранить файл 
RSLogix; щелкните по Save. Затем вы получите приглашение перейти в on-line 
режим; щелкните по Yes.

г.  Выберите режим Remote Run.
13.Повторите эти действия для каждого файла проекта RSLogix 5 (*.rsp). По 
завершении RSLogix 5 и RSNetWorx for ControlNet будут синхронизированы. 

Чтобы получить дополнительную информацию об интеграции RSLogix 5 и RSNet-
Worx for ControlNet, обратитесь к автофаксу Rockwell Software по номеру 440-646-
7777 и запросите документ 300347.  
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Интеграция RSLogix 5 с RSNetWorx: off-line режим с 
использованием Remote I/O (RIO) Allen-Bradley
Для оперативного и эффективного использования RSNetWorx for ControlNet и 
RSLogix 5 в off-line режиме при наличии Remote I/O Allen-Bradley и последующей 
передачи соответствующей информации в вашу интерактивную сеть, выполните 
следующие действия:

Действия приводятся исходя из предположения, что вы уже 
сконфигурировали драйвер связи с помощью RSLinx для сообщения 
со своей сетью ControlNet. 

Откройте файл конфигурации ControlNet (*.xc) и задайте компоновку сети
1.  Задайте компоновку аппаратных средств вашей сети ControlNet  в RSNetWorx for 

ControlNet. Выполните следующее:
а.  Запустите главное окно RSNetWorx for ControlNet и щелкните по триггерной 
кнопке Edits Enabled. 

б.  В окне просмотра Hardware выберите одно из устройств вашей сети ControlNet 
(например, PLC-5C или адаптерный модуль) и перетащите его в область 
конфигурации сети (в графическом или табличном представлении). RSNet-
Worx for ControlNet автоматически присвоит этому устройству очередной из 
имеющихся номеров узла, если он окажется неприемлемым для вашего 
приложения, соответственно измените номер узла. 

     Повторите эти действия для каждого устройства в вашей сети ControlNet.
в.  Щелкните по адаптерному модулю в сетевой конфигурации и задайте 
содержимое шасси, выбрав Device > Define Chassis. В диалоговом окне Define 
Chassis добавьте к данному шасси соответствующие модули для обеспечения 
соответствия с реальным оборудованием, имеющимся в вашей сети. По 
завершении щелкните по OK. 
Повторите для каждого адаптерного модуля в вашей сети ControlNet.

Задайте информацию по локальному рэку 
2.  Задайте в RSNetWorx for ControlNet информацию по локальному рэку, 
необходимую PLC-5C для сообщения по сети ControlNet. Для этого выполните 
следующее:
а.  Щелкните по процессору PLC-5C в сетевой конфигурации, а затем выберите 

Device > Scanlist Configuration.  RSNetWorx for ControlNet  запустит окно 
Scanlist Configuration Tool  и выведет на экран Scan list для выбранного 
процессора PLC-5C. 

     PLC-5C, который вы конфигурируете в данный момент, выделяется зеленым 
цветом. Кроме того, в линейке заголовка выводится имя этого PLC-5C. 
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б.  Щелкните по Device > I/O File Allocation. Задайте информацию по вашему 
локальному рэку, затем щелкните по OK.

в.  Выберите File > Save, чтобы сохранить выполненную вами работу в 
конфигурационном файле ControlNet (*.xc). Впоследствии вы привяжете 
конкретные файлы проекта RSLogix 5 (.rsp) к этому файлу. 

     По завершении закройте Scanlist Configuration Tool. 
3.  Повторите шаг 2 для каждого PLC-5C в вашей сети ControlNet, сохраняя 
внесенные изменения в том же файле конфигурации ControlNet (*.xc), созданном 
в шаге 2в. 

     По завершении сверните главное окно. 

Привяжите каждый PLC-5C к файлу конфигурации ControlNet (*.xc) и задайте 
Remote I/O
4.  В RSLogix 5 создайте новый проект для процессора PLC-5C и привяжите этот 
проект к конфигурационному файлу (*.xc), созданному в шаге 2. Выполните 
следующее:
а.  Запустите RSLogix 5. 
б.  Откройте новый файл проекта, выбрав File > New. В диалоговом окне Select 

Processor Type укажите соответствующую платформу (ControNet), процессор 
PLC-5C (включая серию и версию), имя процессора, драйвер связи, а также 
номер узла для процессора PLC-5C в вашей сети ControlNet. Щелкните по OK.

Для работы с сетью ControlNet вы должны указать один из 
процессоров PLC-5C, за которым должен следовать суффикс 1.5 
(например, PLC-5/40C 1.5). 

в.  В диалоговом окне Select ControlNet Project щелкните по Browse, чтобы найти, 
где находится ваш файл конфигурации ControlNet (*.xc). В диалоговом окне 
Open найдите местоположение соответствующей директории на вашем 
компьютере, а затем выберите имя для файла конфигурации ControlNet, 
созданного в шаге 2в. По завершении щелкните по Open.

     Когда вы вернетесь в диалоговое окно Select ControlNet Project, задайте адрес 
узла, по которому находится указанный процессор PLC-5C в вашей сети Con-
trolNet, а затем щелкните по OK.

5.  Сконфигурируйте настройки таблицы данных Remote I/O для вашей сети Control-
Net. Выполните следующее:
а.  В дереве управления проектом выберите иконку Channel Configuration. 
Щелкните правой кнопкой мыши и выберите Open. 
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б. Согласуйте ваши настройки канала Remote I/O с вашим конкретным 
приложением. По завершении щелкните по Apply, а затем закройте 
соответствующие диалоговые окна. 

в. После выполнения этих действий закройте диалоговое окно Edit Channel Prop-
erties. 

6. Выберите File > Save, чтобы сохранить ваш файл проекта RSLogix (*.rsp). Задайте 
имя для вашего файла проекта RSLogix 5, а затем щелкните по Save. Все 
изменения будут также привязаны к файлу конфигурации ControlNet (*.xc), 
созданному вами в шаге 4. 

По завершении закройте файл проекта RSLogix 5.
7. Выполните шаги с 4 по 6 для каждого процессора PLC-5C в вашей сети ControlNet. 
Имейте ввиду, что для каждого PLC-5C в вашей сети вы будете осуществлять 
привязку к одному и тому же файлу конфигурации ControlNet (*.xc), заданному в 
шаге 2в. По завершении сверните RSLogix 5. 

Добавьте соединения
8.  В RSNetWorx for ControlNet задайте местоположение входа, выхода таблиц 
данных, а также целочисленных файлов, необходимых PLC-5C для сообщения по 
сети ControlNet. Для этого выполните следующее:
а.  Разверните главное окно RSNetWorx for ControlNet и щелкните по триггерной 
кнопке Edits Enabled. Для каждого PLC-5C, который вы активно редактируете 
в своей сети ControlNet, запустится отдельное окно Scanlist Configuration Tool. 

При работе в off-line режиме количество сканирующих устройств 
(например, процессоров PLC-5C), которое может быть 
запланировано в сети ControlNet, зависит от конкретной 
операционной системы, а также объема RAM, имеющегося на 
компьютере. За дополнительной информацией обращайтесь к 
документу по техническим возможностям. 

б.  Щелкните по процессору PLC-5C в сетевой конфигурации главного окна 
RSNetWorx for ControlNet, а затем выберите Device > Scanlist Configuration.  
RSNetWorx for ControlNet  выведет на экран окно Scanlist Configuration Tool, 
содержащее Scan list для выбранного процессора PLC-5C. PLC-5C, который вы 
конфигурируете в данный момент, выделяется зеленым цветом. Кроме того, 
имя этого PLC-5C выводится в линейке заголовка. 

в.  Щелкните по устройству, с которым вы хотите установить соединение, а затем 
выберите Connection > Insert. В диалоговом окне Connection Properties задайте 
все атрибуты конфигурации ControlNet, связанные с данным соединением. По 
завершении щелкните по OK.
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Повторите эти действия для каждого устройства в сети ControlNet, к которому 
вы хотите подключиться. 

Вы можете установить соединения по умолчанию со всеми 
устройствами в сети ControlNet или с выбранным набором 
устройств в сети ControlNet. Выберите Connection > Auto In-
sert > All Devices, чтобы провести поиск по всем устройствам в 
данной конфигурации и добавить недостающее соединение. 
Выберите Connection > Auto Address > All Entries, чтобы 
система смогла выбрать очередной несконфигурированный 
адрес из имеющихся и определить связанные с ControlNet 
файлы (например, статуса, конфигурации, входных данных и 
выходных данных), необходимые для каждого соединения. 

9.  Повторите шаг 8 для каждого PLC-5C в вашей сети ControlNet.
10.Чтобы сохранить выполненную вами работу в конфигурационном файле Control-

Net (*.xc), выберите File > Save в главном окне. 
     По завершении сверните каждое окно Scanlist Configuration Tool. После этого 
сверните главное окно.

Задайте информацию по конфигурации модуля
11.Находясь в RSLogix 5, сконфигурируйте каждый модуль и сохраните данные по 
конфигурации в таблице данных процессора. Чтобы определить эти ячейки в 
RSLogix5, выполните следующее:
а.  Разверните RSLogix 5.
б.  Откройте файл проекта RSLogix 5 (*.rsp) для процессора PLC-5C.
в.  В дереве управления проектом выберите иконку I/O Configuration. Щелкните 
правой кнопкой мыши и выберите Open. В диалоговом окне I/O Configuration 
– Chassis Table показаны все устройства, с которыми сообщается данный 
процессор, а также соответствующая информация по отображению ввода-
вывода. 

г.  Выберите шасси, содержащее модуль, который вы хотите сконфигурировать в 
сети ControlNet. Щелкните правой кнопкой мыши и выберите Display Chassis. 
RSNetWorx for ControlNet автоматически добавит и покажет каждый из 
модулей в этом шасси, с которыми сообщается данный PLC-5C. 

     Выберите тип модуля в данном шасси, который вы хотите сконфигурировать. 
Щелкните правой кнопкой мыши и выберите Display Module. В диалоговом 
окне Module Configuration для выбранного модуля сконфигурируйте модуль 
для вашего приложения. По завершении щелкните по Accept Edits, затем по 
Close. Закройте соответствующие диалоговые окна. 
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Повторите эти действия для всех модулей в данном шасси, к которым это 
применимо. 

На экране появится главное окно RSNetWorx for ControlNet, 
указывая на то, что в RSLogix 5 были внесены изменения. 
Сверните главное окно. 

12.Введите  соответствующую релейную логику для данного процессора PLC-5C.
13.Выберите File > Save, чтобы сохранить файл проекта RSLogix (*.rsp) для данного 
процессора PLC-5C. На этом этапе соответствующие изменения фиксируются в 
указанном файле проекта RSLogix 5, а все ждущее обработки редактирование 
включается в связанный с ним файл .xc. Закройте файл проекта RSLogix 5.

14.Повторите шаги с 11 по 13 для каждого процессора PLC-5C в вашей сети Control-
Net.

     По завершении сверните RSLogix 5. 

Добавьте редакционные изменения, внесенные в RSLogix 5
15.Находясь в RSNetWorx for ControlNet, включите изменения для каждого PLC-5C 
в сети, сделанные в RSLogix 5, в конфигурационный файл (*.xc) ControlNet, 
созданный в шаге 2в. Выполните следующее:
а.  Разверните главное окно RSNetWorx for ControlNet и включите триггерную 
кнопку Edits Enabled. Все изменения, сделанные в RSLogix 5, автоматически 
перейдут в категорию ждущих обработки. 

В каждом окне Scanlist Configuration Tool вы можете увидеть 
изменения, внесенные в модули в RSLogix 5. Эти изменения 
будут показаны текстом синего цвета (ждущие обработки 
редакционные изменения). 

б.  В главном окне (или любом окне Scanlist Configuration Tool) выберите File > 
Save, чтобы включить все ждущие обработки изменения, внесенные в RSLogix 
5, в соответствующий файл *.xc. В диалоговом окне Save configuration 
выберите нужную опцию сохранения и щелкните по OK.

в.  Сверните все окна Scanlist Configuration Tool.
     Теперь конфигурирование вашей системы завершено.
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Загрузите файл конфигурации ControlNet (*xc), содержащий Scan list PLC-5C
16.Находясь в RSNetWorx for ControlNet, подключитесь к интерактивной сети Con-

trolNet и загрузите объединенный конфигурационный файл (*.xc). Выполните 
следующее:
а.  Выберите Network > Online. В диалоговом окне Network Browse выберите сеть 

ControlNet, в которую вы хотите загрузить объединенный конфигурационный 
файл (*.xc). Щелкните по OK.

Если появится диалоговое окно Online/Offline Mismatch, 
укажите, что вы хотите использовать офлайновую 
информацию, и загрузите ее в сеть. Щелкните по OK.

     Если диалоговое окно Online/Offline Mismatch не появится, выберите Network 
> Download. 

б.  Закройте главное окно RSNetWorx for ControlNet. Каждое из окон Scanlist Con-
figuration Tool закроется автоматически. 

Загрузите и синхронизируйте файл проекта RSLogix 5 (*.rsp) с интерактивным 
PLC-5C
17.Находясь в RSLogix 5, откройте каждый файл проекта (*.rsp), созданный для 
каждого узла PLC-5C в вашей сети. Выполните следующее: 
а.  Выберите Comms > System Comms. В диалоговом окне Communications 
выберите соответствующий узел, после чего щелкните по Download. Появится 
приглашение продолжить загрузку; щелкните по Yes.

б.  Появится приглашение сохранить существующую интерактивную 
конфигурацию; щелкните по Yes. Появится приглашение продолжить 
загрузку; щелкните по Yes.

в.  В диалоговом окне Save Program As вы получите приглашение сохранить файл 
RSLogix; щелкните по Save. Затем вы получите приглашение перейти в on-line 
режим; щелкните по Yes.

г.  Выберите режим Remote Run.
18.Повторите эти действия для каждого файла проекта RSLogix 5 (*.rsp). По 
завершении RSLogix 5 и RSNetWorx for ControlNet будут синхронизированы. 

Чтобы получить дополнительную информацию об интеграции RSLogix 5 и RSNet-
Worx for ControlNet, обратитесь к автофаксу Rockwell Software по номеру 440-646-
7777 и запросите документ 300347.  
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Интеграция RSLogix 5 с RSNetWorx: on-line режим с 
использованием Remote I/O (RIO) Allen-Bradley
Для оперативного и эффективного использования RSNetWorx for ControlNet и 
RSLogix 5 в on-line режиме при наличии Remote I/O Allen-Bradley выполните 
следующие действия:

Действия приводятся исходя из предположения, что вы уже 
сконфигурировали драйвер связи с помощью RSLinx для сообщения 
со своей сетью ControlNet. 

Откройте файл конфигурации ControlNet (*.xc) и задайте компоновку сети
1.  Задайте компоновку аппаратных средств вашей сети ControlNet  в RSNetWorx for 

ControlNet. Выполните следующее:
а.  Запустите главное окно RSNetWorx for ControlNet и выберите Network > On-

line. 
б.  В диалоговом окне Browse for Network выберите путь связи с вашей сетью Con-

trolNet, затем щелкните по OK. Дождитесь, пока закончится выполнение 
операции просмотра, прежде чем переходить к следующему шагу. На экране 
появится вся конфигурация сети.

Если появится диалоговое окно Online/Offline Mismatch, 
выберите опцию “use the offline data (download)”, а затем 
щелкните по OK..

в.  Щелкните по триггерной кнопке Edits Enabled.
Задайте информацию по локальному рэку 
2.  Задайте в RSNetWorx for ControlNet информацию по локальному рэку, 
необходимую PLC-5C для сообщения по сети ControlNet. Для этого выполните 
следующее:
а.  Щелкните по процессору PLC-5C в сетевой конфигурации, а затем выберите 

Device > Scanlist Configuration.  RSNetWorx for ControlNet  запустит окно 
Scanlist Configuration Tool  и выведет на экран Scan list для выбранного 
процессора PLC-5C. 

     PLC-5C, который вы конфигурируете в данный момент, выделяется зеленым 
цветом. Кроме того, в линейке заголовка выводится имя этого PLC-5C. 
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б.  Выберите File > Save, чтобы сохранить выполненную вами работу в 
конфигурационном файле ControlNet (*.xc). Впоследствии вы привяжете 
конкретные файлы проекта RSLogix 5 (.rsp) к этому файлу. 

     По завершении закройте Scanlist Configuration Tool. 
3.  Повторите шаг 2 для каждого PLC-5C в вашей сети ControlNet, сохраняя 
внесенные изменения в том же файле конфигурации ControlNet (*.xc), созданном 
в шаге 2б. 

     По завершении сверните главное окно. 

Привяжите каждый PLC-5C к файлу конфигурации ControlNet (*.xc) и задайте 
Remote I/O
4.  В RSLogix 5 создайте новый проект для процессора PLC-5C и привяжите этот 
проект к конфигурационному файлу (*.xc), созданному в шаге 2. Выполните 
следующее:
а.  Запустите RSLogix 5, затем выберите Comms > Who ActiveGo Online.
б.  В диалоговом окне Communications выберите процессорный узел PLC-5C, 
затем щелкните по OK.

в.  В диалоговом окне Default Program Rename  введите имя для выбранного 
процессора PLC-5C, затем щелкните по OK. Образ процессора будет загружен 
в файл проекта RSLogix 5 (*.rsp).

Если у PLC-5C уже есть имя, на экране появится диалоговое 
окно Going to Online. Щелкните по Create New File. 

г.  В дереве управления проекта выберите иконку Controller Properties. Щелкните 
правой кнопкой мыши и выберите Open. В диалоговом окне Controller Proper-
ties щелкните по Browse, чтобы найти, где находится ваш файл конфигурации 
ControlNet (*.xc). В диалоговом окне Open найдите местоположение 
соответствующей директории на вашем компьютере, а затем выберите имя для 
файла конфигурации ControlNet, созданного в шаге 4. По завершении 
щелкните по Open.
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     Когда вы вернетесь в диалоговое окно ControlNet Properties, задайте адрес узла, 
по которому находится указанный процессор PLC-5C в вашей сети ControlNet, 
а затем щелкните по OK.

Необязательно вводить какое-либо значение в поле ControlNet 
Source Link ID. За дополнительной информацией о поле Con-
trolNet Source Link ID обращайтесь к интерактивной 
справочной системе RSLogix 5. 

5.  Сконфигурируйте настройки таблицы данных Remote I/O для вашей сети Control-
Net. Выполните следующее:
а.  В дереве управления проектом выберите иконку Channel Configuration. 
Щелкните правой кнопкой мыши и выберите Open. 

б.  Согласуйте ваши настройки канала Remote I/O с вашим конкретным 
приложением. По завершении щелкните по Apply, а затем закройте 
соответствующие диалоговые окна. 

в.  После выполнения этих действий закройте диалоговое окно Edit Channel Prop-
erties. 

6.  Выберите File > Save, чтобы сохранить ваш файл проекта RSLogix (*.rsp). Задайте 
имя для вашего файла проекта RSLogix 5, а затем щелкните по Save. Вы получите 
приглашение загрузить ваши изменения; щелкните по Yes. На этом этапе 
соответствующие изменения фиксируются в указанном файле проекта RSLogix 5. 
Кроме того, все изменения будут также привязаны к файлу конфигурации Control-
Net (*.xc), созданному вами в шаге 4. 

     По завершении закройте файл проекта RSLogix 5.
7.  Выполните шаги с 4 по 6 для каждого процессора PLC-5C в вашей сети ControlNet. 
Имейте ввиду, что для каждого PLC-5C в вашей сети вы будете осуществлять 
привязку к одному и тому же файлу конфигурации ControlNet (*.xc), заданному в 
шаге 1г. По завершении сверните RSLogix 5. 

Подсказка
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Добавьте соединения
8.  В RSNetWorx for ControlNet задайте задайте соединения, необходимые PLC-5C 
для сообщения по сети ControlNet. Для этого выполните следующее:
а.  Разверните главное окно RSNetWorx for ControlNet и щелкните по триггерной 
кнопке Edits Enabled. Для каждого PLC-5C, который вы активно редактируете 
в своей сети ControlNet, запустится отдельное окно Scanlist Configuration Tool. 

При работе в off-line режиме количество сканирующих 
устройств (например, процессоров PLC-5C), которое может 
быть запланировано в сети ControlNet, зависит от конкретного 
устройства связи и операционной системы. За дополнительной 
информацией обращайтесь к документу по техническим 
возможностям. 

б.  Щелкните по процессору PLC-5C в сетевой конфигурации, а затем выберите 
Device > Scanlist Configuration.  RSNetWorx for ControlNet  запустит окно 
Scanlist Configuration Tool и выведет на экран Scan list для выбранного 
процессора PLC-5C. 

     PLC-5C, который вы конфигурируете в данный момент, выделяется зеленым 
цветом. Кроме того, имя этого PLC-5C выводится в линейке заголовка. 

в.  Щелкните по устройству, с которым вы хотите установить соединение, а затем 
выберите Connection > Insert. В диалоговом окне Connection Properties задайте 
все атрибуты конфигурации ControlNet, связанные с данным соединением. По 
завершении щелкните по OK. 

     Повторите эти действия для каждого устройства в сети ControlNet, к которому 
вы хотите подключиться. 

Вы можете установить соединения по умолчанию со всеми 
устройствами в сети ControlNet или с выбранным набором 
устройств в сети ControlNet. Выберите Connection > Auto In-
sert > All Devices, чтобы провести поиск по всем устройствам в 
данной конфигурации и добавить недостающее соединение. 
Выберите Connection > Auto Address > All Entries, чтобы 
система смогла выбрать очередной несконфигурированный 
адрес из имеющихся и определить связанные с ControlNet 
файлы (например, статуса, конфигурации, входных данных и 
выходных данных), необходимые для каждого соединения. 

Подсказка
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9.  Повторите шаг 8 для каждого PLC-5C в вашей сети ControlNet.

Имейте ввиду, что для каждого PLC-5C, который вы активно 
редактируете в своей сети ControlNet, запустится отдельное окно 
Scanlist Configuration Tool. 

10.Чтобы сохранить выполненную вами работу в конфигурационном файле Control-
Net (*.xc), выберите File > Save в главном окне. 

     По завершении сверните каждое окно Scanlist Configuration Tool. После этого 
сверните главное окно.

Задайте информацию по конфигурации модуля
11.Сконфигурируйте каждый модуль и сохраните данные по конфигурации в 
таблице данных процессора. Чтобы определить эти ячейки в RSLogix5, 
выполните следующее:
а.  Находясь в RSLogix 5,  откройте файл проекта RSLogix 5 (*.rsp) для PLC-5C и 
выберите Comms > Go Online.

б.  В диалоговом окне Going to Online Programming State щелкните по Upload Use 
File. Образ процессора загрузится в файл проекта RSLogix 5 (*.rsp).

в.  В дереве управления проектом выберите иконку I/O Configuration. Щелкните 
правой кнопкой мыши и выберите Open. В диалоговом окне I/O Configuration 
– Chassis Table показаны все устройства, с которыми сообщается данный 
процессор, а также соответствующая информация по отображению ввода-
вывода. 

г.  Выберите шасси, содержащее модуль, который вы хотите сконфигурировать в 
сети ControlNet. Щелкните правой кнопкой мыши и выберите Display Chassis. 
RSNetWorx for ControlNet автоматически добавит и покажет каждый из 
модулей в этом шасси, с которыми сообщается данный PLC-5C. 

д.  Выберите тип модуля в данном шасси, который вы хотите сконфигурировать. 
Щелкните правой кнопкой мыши и выберите Display Module. В диалоговом 
окне Module Configuration для выбранного модуля сконфигурируйте модуль 
для вашего приложения. По завершении щелкните по Accept Edits, затем по 
Close. Закройте соответствующие диалоговые окна. 

Подсказка
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     Повторите эти действия для всех модулей в данном шасси, к которым это 
применимо. 

На экране появится главное окно RSNetWorx for ControlNet, 
указывая на то, что в RSLogix 5 были внесены изменения. 
Сверните главное окно. 

12.Введите  соответствующую релейную логику для данного процессора PLC-5C.
13.Выберите File > Save, чтобы сохранить файл проекта RSLogix (*.rsp) для данного 
процессора PLC-5C. 

14.Выберите Comms > Download. Вы получите приглашение сохранить 
существующие изменения; щелкните по Yes. На этом этапе соответствующие 
изменения фиксируются в указанном файле проекта RSLogix 5, а все ждущее 
обработки редактирование включается в связанный с ним файл .xc. Закройте файл 
проекта RSLogix 5.

15.Повторите шаги с 11 по 14 для каждого процессора PLC-5C в вашей сети Control-
Net. 

Обязательно задайте уникальный номер узла ControlNet для 
каждого процессора PLC-5C в вашей сети ControlNet.

     По завершении сверните RSLogix 5.

Добавьте редакционные изменения, внесенные в RSLogix 5
16.Находясь в RSNetWorx for ControlNet, включите изменения для каждого PLC-5C 
в сети, сделанные в RSLogix 5, в конфигурационный файл (*.xc) ControlNet, 
созданный в шаге 2. Выполните следующее:
а.  Разверните главное окно RSNetWorx for ControlNet и включите триггерную 
кнопку Edits Enabled. Все изменения, сделанные в RSLogix 5, автоматически 
перейдут в категорию ждущих обработки. 

В каждом окне Scanlist Configuration Tool вы можете увидеть 
изменения, внесенные в модули в RSLogix 5. Эти изменения 
будут показаны текстом синего цвета (ждущие обработки 
редакционные изменения). 

Подсказка
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б.  В главном окне (или любом окне Scanlist Configuration Tool) выберите File > 
Save, чтобы включить все ждущие обработки изменения, внесенные в RSLogix 
5, в соответствующий файл *.xc. В диалоговом окне Save configuration 
выберите нужную опцию сохранения и щелкните по OK.

в.  Закройте главное окно. Обратите внимание на то, что все окна Scanlist Config-
uration Tool закрываются автоматически.

     Теперь конфигурирование вашей системы завершено.

Синхронизируйте файл проекта RSLogix 5 (*.rsp) с интерактивным PLC-5C
17.Находясь в RSLogix 5, откройте каждый файл проекта (*.rsp), созданный для 
каждого узла PLC-5C в вашей сети. Выполните следующее: 
а.  Откройте файл проекта RSLogix 5 (*.rsp).
б.  Выберите Comms > Upload, чтобы сохранить конфигурацию сети в 
конфигурационном файле ControlNet (*.xc). Ваша офлайновая сеть должна 
соответствовать вашей онлайновой сети. 

в.  Выберите Comms > Go Online.
г.  Выберите режим Remote Run.

18.Повторите эти действия для каждого файла проекта RSLogix 5 (*.rsp). По 
завершении RSLogix 5 и RSNetWorx for ControlNet будут синхронизированы. 

Чтобы получить дополнительную информацию об интеграции RSLogix 5 и RSNet-
Worx for ControlNet, обратитесь к автофаксу Rockwell Software по номеру 440-646-
7777 и запросите документ 300347.
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Глава

В данной главе описывается как:
• Пользоваться оперативной справочной информацией,
• Обращаться к онлайновым книгам,
• Работать с обучающей программой,
• Принять участие в учебных курсах фирмы Rockwell Software,
• Связаться с группой технической поддержки.

Использование онлайновой справочной системы
Система оперативной справочной информации RSNetWorx for  ControlNet 
обеспечивает получение обзорной информации, исчерпывающего пошагового 
описания процедур, описания контекстно-зависимых диалоговых окон управления 
для работы со всеми разделами программного обеспечения. Для просмотра 
оперативной справочной информации при работе RSNetWorx for  ControlNet:
• выберите Contents в меню Help главного окна RSNetWorx for ControlNet,
• щелкните по кнопке Help любого диалогового окна или страницы свойств в RSNet-
Worx for ControlNet,
• установите курсор поверх любого средства управления, о котором вы хотите 
получить справку, и щелкните правой кнопкой мыши,
• нажмите Fl
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получение справки о средствах управления и полях 
Чтобы вывести на экран определение средства управления или поля, щелкните по 
иконке What's This? в верхнем правом углу диалогового окна, переместите курсор в 
интересующую вас область и щелкните кнопкой мыши. Для вывода на экран 
определения вы можете также щелкнуть правой кнопкой мыши по средству 
управления и выбрать What's This?. В данном примере было выбрано поле Current 
Maximum Scheduled Address.

Получение справки о сообщениях 
В области просмотра сообщений (Message view), которая появляется в нижней части 
рабочей области, выводится на экран регистратор сообщений. Эта область может 
содержать информационные, предупреждающие сообщения  и/или сообщения об 
ошибках.

Чтобы устранить проблемы, связанные с конкретным сообщением, вы можете 
выбрать это сообщение и нажать клавишу Fl для просмотра справочной информации.
58 - Руководство по применению RSNetWorx For ControlNet 



Например, если вы выбрали указанное здесь сообщение с кодом 20008116 и нажали 
Fl, на экране появится раздел справочной системы по устранению проблем “Эта сеть 
сконфигурирована, но отсутствует файл автономной конфигурации (This network is 
configured and there is no offline configuration)”.

В области просмотра сообщений вы можете также выделить какое-либо сообщение, 
а затем, для вывода на экран справочной информации по данному сообщению, 
выбрать View > Messages > Troubleshoot.  Вы можете показывать, очищать и/или 
очищать и скрывать сообщения с помощью команды View > Messages главного 
меню. Команда копирования этого меню копирует выбранное сообщение в буфер 
обмена Windows, так, что оно доступно другим приложениям.
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Поиск пошаговых процедур
Чтобы просмотреть список задач, относящихся к текущему тематическому разделу, 
перейдите в область What do you want to do? (Что вы хотите сделать?) внизу окна и 
выберите одну из предлагаемых задач. На экране появится вспомогательное окно с 
пошаговой процедурой для выполнения этой задачи.
Например, если в диалоговом окне раздела справочной системы Configure network 
properties (Конфигурирование свойств сети) вы выберете задачу View network param-
eters (Просмотреть параметры сети) в области “What do you want to do?”, то во 
вспомогательном окне с названием "How to..." (Как …) появится описание 
процедуры просмотра параметров сети.  Кроме того, в разделе справочной системы 
“View network parameters”, фраза “Network Parameters property page” снабжена 
всплывающей навигационной подсказкой.
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Поиск определений
В справочной системе RSNetWorx for ControlNe текст, выделенный пунктирным 
подчеркиванием, снабжен всплывающим определением. Текст, выделенный 
двойным подчеркиванием, указывает на наличие ссылки на соответствующий раздел 
справочной системы. Например, в разделе “Configure network parameters” выражения 
“network update time” и “unscheduled address” снабжены всплывающими 
определениями.
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Доступ к онлайновым книгам
RSNetWorx for ControlNet обеспечивает мгновенный доступ к документации по 
данному продукту с помощью системы онлайновых книг Online Books. Online Books 
содержит данное “Руководство по применению” и много других справочных 
материалов в электронном формате. Для доступа к этой документации выберите 
Help > Online Books.

Обучающая программа
Программное обеспечение RSNetWorx for ControlNet снабжено обучающей 
программной, которая содержит обзорную информацию, специальные задания и 
примеры для обучения пользователя эффективной работе с данным продуктом. Эта 
обучающая программа вызывается следующим образом: Start > Programs > Rock-
well Software > RSNetWorx > RSNetWorx for ControlNet Tutorial.

Курсы обучения
Один из самых эффективных способов повысить ваш профессиональный уровень 
работы с программным обеспечением фирмы Rockwell Software – это принять 
участие в программе обучения, организуемой фирмой Rockwell Software. Наши 
программы обучения помогут вам овладеть основами и полностью использовать 
потенциальные возможности нашего программного обеспечения.
Мы предлагаем широкий спектр программ обучения, от занятий, регулярно 
проводимых на предприятиях фирмы Rockwell Software, до курсов, которые 
проводятся на вашем предприятии в соответствии с вашими потребностями. Состав 
каждой группы невелик, и мы это делаем умышленно для того, чтобы уделить 
максимум внимания каждому обучаемому. 
62 - Руководство по применению RSNetWorx For ControlNet 



Если вам нужна дополнительная информация по программам обучения, обратитесь 
на World Wide Web сайт фирмы Rockwell Software или свяжитесь с координатором 
программ обучения фирмы Rockwell Software. Наш World Wide Web адрес и 
телефонный номер указаны на внутренней стороне обложки данного документа.

Вы можете получить дополнительную информацию о программах 
обучения с помощью меню Help > Support and Training в главном 
окне RSNetWorx for ControlNet.

Техническая поддержка
Если вы не смогли найти ответы на интересующие вас вопросы в “Руководстве по 
применению RSNetWorx for ControlNet”, в онлайновой справочной системе или в 
документации системы Online Books, вы можете позвонить в группу технической 
поддержки фирмы Rockwell Software по телефонам, указанным на внутренней 
стороне обложки данного руководства. Персонал группы технической поддержки 
готов ответить на ваши вопросы с понедельника по пятницу с 9 до 18 часов по 
московскому времени, за исключением праздничных дней. Вы можете также 
получить информацию о Autofax Product Information System из интерактивной 
библиотеки поддержки Rockwell Software (Rockwell Software Online Support Library) 
на web-сайте, указанном на внутренней стороне обложки данного руководства.

Когда вы звоните
Когда вы звоните в группу технической поддержки, вы должны находиться за 
компьютером и быть готовы предоставить следующую информацию:
• серийный номер программного продукта
• номер версии программного продукта
Серийный номер и номер версии можно найти с помощью меню Help > About 
RSNetWorx
• используемое аппаратное обеспечение
• установленные операционная система, пакеты обновления (service packs) и версия 
Internet Explorer (если есть)
• дословный текст всех сообщений об ошибках и других сообщений, появлявшихся 
на экране
• описание происшедшего и того, что вы делали, когда возникла проблема
• описание того, как вы пытались решить проблему

Для получения более подробной информации о технической 
поддержке, предоставляемой Rockwell Software, используйте меню 
Help > Support and Training в главном окне RSNetWorx for Control-
Net.

Подсказка
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Приложение

Программные продукты фирмы Rockwell Software защищены от копирования. Они 
могут работать только на компьютере, имеющем доступ к ключу активации. Этот 
ключ располагается в файле активации, который первоначально располагается на 
мастер-диске, поставляемом вместе с RSNetWorx for ControlNet. Для одного 
программного продукта этот файл содержит один ключ активации. Каждый ключ 
содержит одну или более лицензий в зависимости от того, сколько копий 
программного продукта вы купили.

Храните ваш мастер-диск в безопасном месте. В случае повреждения 
системы активации мастер-диск может оказаться единственным 
средством запуска вашего программного обеспечения при крайней 
необходимости.

В процессе инсталляции программного обеспечения программа установки 
предоставляет вам возможность перенести файл активации с мастер-диска  в 
корневую директорию диска, на котором вы устанавливаете программное 
обеспечение. 
Когда вы запускаете RSNetWorx for ControlNet, это программное обеспечение в 
первую очередь проверяет ваши локальные жесткие диски, затем сетевые жесткие 
диски, и в последнюю очередь - дисководы гибких дисков на предмет наличия файла 
активации. Если система не нашла ни файла активации, ни мастер-диска, вы 
получите сообщение об ошибке, говорящее, что для запуска RSNetWorx for Control-
Net требуется провести активацию.

Системе, подключенной к развитой компьютерной сети, может 
потребоваться достаточно много времени для поиска файлов 
активации на всех доступных дисках. Для того, чтобы задать 
проверяемые дисководы и/или ограничить их, а также задать порядок, 
в котором они будут проверяться, вы можете использовать настройку 
CHECKDRIVES. Описание утилит активации можно найти в 
онлайновой справочной системе с помощью меню Help > Copy Pro-
tection.

Подсказка

Подсказка
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Защита файлов активации

Некоторые антивирусные пакеты, такие как Norton Anti-virus, могут 
повредить файлы активации. Конфигурируйте ваше антивирусное 
программное обеспечение таким образом, чтобы избегать проверок 
файлов EVRSI.SYS и 386SWAP.PAR.

Чтобы избежать повреждения файлов активации, не проводите следующие операции 
над файлами активации на жестком диске.
• Восстановление с резервных копий
• Модернизация операционной системы
• Переустановка той же версии DOS
• Деинсталляция DOS
• Уплотнение и разуплотнение жесткого диска
Утилиты дефрагментации не повреждают файлы активации.
Перед запуском любых утилит, которые могут изменить структуру или организацию 
жесткого диска, перенесите файлы активации с жесткого диска:
1.  Для переноса файлов активации с жесткого диска на диск активации используйте 
утилиту Move Activation (EvMove).

 Не используйте утилиту Move Activation во время работы 
программных продуктов фирмы Rockwell Software. Перед запуском 
утилиты EvMove убедитесь, что все программы закрыты.

Запустите EvMove с помощью меню Start > Progams > Rockwell Software > Util-
ities > Move Activation.

2.  Выполните необходимую операцию с жестким диском.
3.  Перенесите файлы активации назад на жесткий диск.

Для переноса файлов активации вы обязательно должны 
использовать утилиту  EvMove. Попытки скопировать, перенести или 
отправить по файлы активации по электронной почте другими 
способами приведут к их повреждению.

Внимание!

Внимание!

Внимание!
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Активация RSNetWorx for ControlNet
В зависимости от ваших потребностей, вы можете провести активацию RSNetWorx 
for ControlNet любым из следующих способов:
С жесткого диска. Ключ активации находится на жестком диске. Используйте этот 
способ в том случае, если вы собираетесь использовать RSNetWorx for ControlNet в 
основном на одном компьютере. Этот метод используется по умолчанию при 
активации RSNetWorx for ControlNet во время инсталляции. Чтбы запустить RSNet-
Worx for ControlNet на другом компьютере, перенесите ключ активации обратно на 
мастер-диск, а затем на жесткий диск этого другого компьютера.
С дискеты. Ключ активации находится на гибком диске (диске активации). 
Используйте этот способ в том случае, если вы собираетесь использовать RSNetWorx 
for ControlNet более чем на одном компьютере, например, если вы хотите запускать 
RSNetWorx for ControlNet  то на стационарном компьютере, то на ноутбуке. 
С сетевого дисковода. Ключ активации находится на сетевом дисководе. 
Используйте этот способ в том случае, если вы купили несколько лицензий на 
программное обеспечение и хотите, чтобы несколько пользователей имели 
возможность активировать программный продукт по сети. Обратитесь к онлайновой 
справочной системе за инструкциями по перемещению ключа активации на сетевой 
дисковод (за описанием работы с онлайновой справочной системой обратитесь к 
разделу “Поиск дополнительной информации об активации” данного руководства).

Запуск утилит активации
Утилиты активации и восстановления активации называются соответственно Ev-
Move и Reset. Утилита Reset используется при повреждении файла активации. 
Файлы EVMOVE.EXE и RESET.EXE располагаются на жестком диске вашего 
компьютера (в директории C:\Program Files\Rockwell Software\RSUtil, если вы 
приняли путь к директории по умолчанию во время инсталляции). Чтобы запустить 
эти программы выберите  Start > Programs > Rockwell Software > Utilities > Move 
Activation или Reset Activation.
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Поиск дополнительной информации об активации
Онлайновая справочная система (COPYPROT.HLP) предоставляет более полную 
информацию об активации, включая такие понятия как:
KEYDISK (Ключевой диск). Задайте эту переменную среды, чтобы ваш компьютер 
искал файл активации на гибких дисках.
CHECKDRIVES (Проверка дисководов). Задайте, какие дисководы используются 
при поиске файла активации.
network activation (сетевая активация). Перенесите файл активации на сетевой 
сервер, чтобы позволить нескольким пользователям получить доступ к файлу 
активации.
moving activation (перенос активации). Прочтите подробные инструкции по 
переносу файлов активации.
resetting activation (восстановление активации). Прочтите подробные инструкции 
по использованию утилиты Reset для восстановления поврежденного файла 
активации.
troubleshooting (устранение проблем). Найдите сообщения об ошибках, получите 
предложения по решению проблем.
Вы можете обратиться к онлайновой справочной системе:
• с помощью кнопки Help в одном из диалоговых окон EvMove или Reset.
• из главного меню RSNetWorx for ControlNet, выбрав Help > Copy Protection.
• без запуска RSNetWorx for ControlNet или утилит активации. Из меню Windows 
Start, выбрав Programs > Rockwell Software > Utilities > Activation Help.
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Некоторые общие вопросы
Ниже представлены несколько общих проблем, с которыми сталкиваются 
пользователи при активации, и их решения.

Мои файлы активации были повреждены. Что я должен делать?
Если вы лишились активации в результате повреждения файлов активации, вам 
необходимо ее восстановить. Следуйте инструкциям раздела Reset Codes на web-
страничке Rockwell Software Technical Support или позвоните по телефону группы 
технической поддержки. Адрес web-страницы и телефонный номер указаны на 
внутренней стороне обложки данного руководства.
Если вам не удалось быстро получить специальный код для восстановления, в 
качестве временной меры используйте мастер-диск для активации программного 
обеспечения.
Чтобы использовать мастер-диск:
1.  Задайте значение TRUE для переменной среды KEYDISK. Вы можете обратиться 
к онлайновой справочной системе за дополнительной информацией, выбрав Start 
> Program Files > Utilities > Activation Help.

2.  Вставьте мастер-диск в дисковод гибких дисков.
3.  Обычным образом запустите программное обеспечение. Ваше программное 
обеспечение найдет файл активации на мастер-диске.

Я случайно уничтожил директорию с программным обеспечением на 
своем жестком диске. Нужно ли мне звонить на фирму Rockwell Soft-
ware для замены файлов активации?
Нет. Уничтожение программных файлов не означает уничтожение файлов 
активации. Файлы активации не хранятся в программной директории, они 
расположены в корневой директории. Файлы активации не будут уничтожены до тех 
пор, пока вы не переформатируете жесткий диск, не испортите скрытые файлы в 
корневой директории или не выполните с жестким диском одну из перечисленных 
операций (для получения подробной информации обратитесь к разделу “Защита 
файлов активации” данной главы).
Чтобы программное обеспечение заработало вновь, просто деинсталлируйте его с 
помощью меню панели управления Добавить/Удалить программы (Add/Remove Pro-
grams), затем переустановите программное обеспечение, но не перемещайте файлы 
активации.
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Почему я не могу переместить файлы активации на новый гибкий диск 
под Windows NT?
Это связано с модификацией диска, которую NT сделать не позволяет. Если у вас 
есть машина с Windows 95 или 98, вы можете создать диск, который будет работать 
под NT. Отформатируйте гибкий диск, переместите на него файл активации под Win-
dows 95 или 98. (Вы сможете переместить файл активации назад с этого диска, если 
вы захотите хранить его там, где он был.) Используйте эту дискету на машине с NT 
и переместите файл активации на нее.
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Activation disk (диск активации) – Любой диск (гибкий или жесткий), 
содержащий файл активации. Диск активации может использоваться для 
активации программного продукта. Он отличается от ключевого диска (мастер-
диска) тем, что для активации программного продукта на диске активации должна 
находиться хотя бы одна лицензия на соответствующий программный продукт. 
Active keeper (активный кипер) – Активный кипер представляет собой узел, 
отвечающий за рассылку периодического широковещательного сообщения 
кипера по сети ControlNet, а также за ответ на запросы сигнатур сканирующих 
устройств, поступающие от каких-либо других узлов с запланированными 
соединениями в этой сети. Периодическое широковещательное сообщение 
кипера, рассылаемое активным кипером, представляет собой прозрачное 
запланированное сообщение, содержащее следующую информацию:
• том, какой кипер должен быть активным
• сигнатуре всей сети
•каких-либо ждущих обработки операциях по внесению в сеть изменений и 
ресурсах    сетевого управления
Во всякой сети должен иметься активный кипер для внесения в сеть ControlNet 
изменений или для инициирования запланированных соединений. После 
включения в сеть каждый новый узел с запланированными соединениями 
свяжется с активным кипером для проверки сигнатур сканирующих устройств для 
данной конфигурации ControlNet. Если сигнатуры сканирующих устройств 
окажутся совместимыми, узел может присоединиться к данной сети, и 
устанавливаются запланированные соединения. 
Если в сети имеется более одного узла, способного выступать в качестве кипера, 
лишь один из таких узлов может быть активным кипером. За дополнительной 
информацией обращайтесь к статьям по одиночному киперу и мультикиперу. 
Activation file (файл активации) – Скрытый защищенный от записи системный 
файл, который «активирует» программный продукт Rockwell Software. 
Программный продукт будет работать лишь в том случае, если система сможет 
найти верный файл активации. 
Activation key (ключ активации) – Файлы активации содержат базу данных 
ключей активации. Каждому продукту соответствует свой уникальный ключ, 
который должен быть доступен через локальный или удаленный дисковод для 
запуска данного продукта.   
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Actual packet interval (фактический межпакетный интервал) – Значение 
фактического межпакетного интервала (API) определяется на основе NUI и всегда 
меньше или равно RPI. Значение API – это максимальное двоичное кратное (1, 2, 4, 
8, 16, 32, 64 или 128) NUT, значение которого меньше или равно RPI. 
Average scheduled bandwidth (средняя полоса пропускания запланированных 
данных) – Выражается в процентах и определяется путем усреднения процента 
NUT, использованного для обмена запланированными данными, по 128 интервалам 
обновления сети для данной конфигурации.
Configuration file (файл конфигурации) – Файл конфигурации представляет собой 
задаваемый пользователем целочисленный файл данных или группу смежных 
файлов  данных, ограничиваемый лишь имеющимся объемом памяти. В этом файле 
сохраняется информация по каждой из соответствующих записей о соединении, 
включая все аналоговые записи.  Если вы зададите файл конфигурации для какой-
либо записи о соединении, содержимое адреса таблица данных будет направляться к 
соответствующему устройству всякий раз при установлении соединения. 
Connection (логическое соединение) – Открытый коммуникационный путь с 
логической связью между двумя устройствами в сети ControlNet.
Connection ID (идентификатор соединения) – Идентификатор, присваиваемый 
конкретному соединению между потребителем (customer) и производителем (produc-
er) и обозначающий избранную прикладную информацию. 
Connection type (тип соединения) – Тип соединения указывает на отношение узла к 
данным. Он определяет правило, по которому запись о соединении управляет 
выходными данными, передаваемыми в рэк, модуль или устройство. Стандартными 
типами соединения являются следующие:
•   Exclusive Owner (эксклюзивный владелец) – определяет независимое соединение, 
при котором одно устройство управляет состояниями вывода в целевом 
устройстве. Если у вас имеется соединение типа Exclusive Owner с целевым 
устройством, вы не можете задать другое соединение типа Exclusive Owner или 
Redundant с тем же самым целевым устройством. 

Соединения с модулем 1771 могут быть успешными лишь в том 
случае, если уже имеется соединение типа Exclusive Owner с рэком. 
Также лишь процессор PLC-5C, имеющий соединение типа Exclusive 
Owner с адаптером, может иметь соединение типа Exclusive Owner с 
модулем. 

•    Input Only (только ввод) – определяет независимое соединение, при котором 
устройство получает входные данные от целевого устройства и посылает в сеть 
данные о конфигурации. При соединении типа Input Only выходные данные не 
посылаются; лишь принимаются входные данные. Можно задать несколько 
соединений типа Input Only с целевым устройством от различных инициаторов. 

Подсказка
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•    Listen Only (только прослушивание) – определяет зависимое соединение, при котором 
устройство получает входные данные от целевого устройства, но не посылает данные 
о конфигурации по сети. Соединение Listen Only правильно функционирует лишь 
тогда, когда существует другое соединение типа, отличного от Listen Only, с тем же 
самым целевым устройством. При соединении типа Listen Only выходные данные не 
посылаются; лишь принимаются входные данные. Можно задать несколько 
соединений типа Listen Only с целевым устройством от различных инициаторов. 

Все соединения типа Listen Only будут прерваны при отмене связанных 
с ними независимых соединений. 

•    Redundant (резервный) – определяет независимое соединение, при котором первичное 
и вторичное устройство совместно управляют выходами и посылают данные по 
конфигурации в сеть. Если у вас имеется соединение типа Redundant с целевым 
устройством, вы можете задать другое соединение типа Redundant с тем же самым 
целевым устройством, но не можете задать соединение типа Exclusive Owner. 

Этот тип соединения используется с системой горячего резервирования 
PLC-5 в ControlNet (ControlNet PLC-5 Hot Backup system).

Consumer (потребитель) – Узел, получающий данные от производителя по локальной 
сети ControlNet.
ControlNet network (сеть ControlNet) – Сеть автоматизации промышленного 
производства, финансируемая фирмой ControlNet International. 
Data Input File (DIF) (файл данных ввода) – Файл данных ввода представляет собой 
задаваемый пользователем целочисленный файл данных или группу смежных 
целочисленных файлов данных (до четырех). Процессоры PLC-5C используют этот файл 
для совместного использования недискретных данных ввода и запланированных 
одноранговых данных ввода в сети ControlNet. Максимальное количество слов, которое 
может содержаться в файле данных ввода, зависит от процессора. 

Например, если вы зададите файл данных ввода (Data Input File) как N34, а размер файла 
данных ввода (Data Input File Size) как 4000 слов, то RSNetWorx for ControlNet 
автоматически создаст целочисленные файлы N34, N35, N36 и N37, каждый длиной 1000 
слов.

Процессор Максимальное количество 
слов

Количество файлов

5/20C 2000 2

5/40C 3000 3

5/60C, 5/80C 4000 4

Подсказка

Подсказка
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Data output file (DOF) (файл данных вывода) – Файл данных вывода представляет 
собой задаваемый пользователем целочисленный файл данных. Процессоры PLC-5C 
используют этот файл для совместного использования недискретных данных вывода и 
запланированных одноранговых данных вывода в сети ControlNet. Максимальное 
количество слов, которое может содержаться в файле данных вывода, зависит от 
процессора. 

Например, если вы зададите файл данных ввода (Data Output File) как N30, а размер 
файла данных вывода (Data Output File Size) как 4000 слов, то RSNetWorx for ControlNet 
автоматически создаст целочисленные файлы N30, N31, N32 и N33, каждый длиной 
1000 слов.
Discrete input (output) data (дискретные данные ввода (вывода)) – Данные, 
поступающие от соединения рэка (шасси). Как правило, это массив битов, каждый из 
которых представляет точку коммутации в виде дискретного (одиночного) поля. 
Diagnostic file (файл диагностики) – Файл диагностики представляет собой 
задаваемый пользователем файл данных, начинающийся с нулевого слова. В этом файле 
хранятся счетчики диагностики процессора PLC-5C для канала ControlNet.

Использование этого файла является необязательным. Его задание 
приводит к дополнительному трафику в сети ControlNet. За техническим 
описанием обращайтесь к Руководству пользователя программируемых 
контроллеров PLC-5 ControlNet, Фаза 1.5 (публикация № 1785-6.5.22).

Процессор Максимальное количество слов Количество файлов

5/20C 2000 2

5/40C 3000 3

5/60C, 5/80C 4000 4

Если вы используете этот процессор 
PLC-5C:

Файл диагностики 
может включать:

Серия F, версия A или выше 63 слова

Серия E, версия D или выше 63 слова

Серия D, версия E или выше 63 слова

Серия C, версия N или выше 63 слова

Серия E, версия C или ниже 40 слов

Серия D, версия D или ниже 40 слов

Серия C, версия M или ниже 40 слов
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Invalid keeper (недействительный кипер) – Недействительный кипер представляет 
собой любое способное быть кипером устройство, которое присоединилось к 
существующей сети, но имеет несовпадающую сетевую сигнатуру с текущим 
активным кипером. Недействительный кипер автоматически возьмет на себя роль 
активного кипера, если в сети нет других действительных киперов.  
Keeper signature (сигнатура кипера) – Представляет собой уникальное 
шестнадцатеричное значение, сохраняемое всяким способным выступать в качестве 
кипера устройством для уникальной идентификации конкретной конфигурации сети. 
При первоначальном запуске способное быть кипером устройство определяет:
•сконфигурировало ли ранее сеть иное способное быть кипером устройство.
•соответствует ли его внутренняя сигнатура сетевой сигнатуре.
Если сигнатуры совпадают, способное быть кипером устройство присоединяется к 
сети в качестве действительного кипера. Если сигнатуры не совпадают, данный 
кипер присоединяется к сети как недействительный кипер. 
Key disk (ключевой диск) – Гибкий диск, который может использоваться для 
активации программного продукта, даже если на этом диске нет ни одной лицензии. 
Единственным ключевым диском является мастер-диск. Он отличается от диска 
активации тем, что на диске активации должна находиться хотя бы одна лицензия. 
License (лицензия) – Разрешение на использование определенного количества 
экземпляров программного продукта. Ключ активации программного продукта 
содержит лицензию для каждой копии приобретенного вами программного 
продукта. Например, если вы приобрели семь копий RSLogix 5, то ключ RSLogix 5 
на мастер-диске будет содержать семь «лицензий» на RSLogix 5. Вы можете 
перенести ключ активации RSLogix 5 на семь различных компьютеров. 
Macrocycle (макроцикл) – Макроцикл равняется 128 NUI (интервалам обновления 
сети). Макроцикл – это максимальный период времени перед повторением 
запланированного трафика. 
Maintenance message (поддерживающее сообщение) – Позволяет узлу с самым 
низшим адресом поддерживать синхронизацию остальных узлов. Это время 
автоматически вычитается из периода обновления сети (NUT).
Master disk (мастер-диск) – Этот диск поставляется в комплекте с программным 
продуктом. Он содержит базу данных ключей, находящуюся в «файле активации» и 
позволяющую использовать программный продукт. Обеспечьте сохранность мастер-
диска. Если ваш файл активации будет поврежден, вы сможете запустить ваш 
программный продукт только с мастер-диска (пока не будет восстановлена 
активация). 
Maximum scheduled node (максимальный запланированный узел) – Это узел с 
наивысшим сетевым адресом, который может использовать время запланированного 
обмена в сети ControlNet.
Maximum unscheduled node (максимальный незапланированный узел) – Это 
узел с наивысшим сетевым адресом, который может использовать время 
незапланированного обмена в сети ControlNet.
Узлы, заданные по адресам, превышающим адрес максимального 
незапланированного узла, не будут осуществлять обмен данными по сети; например, 
они не будут отображены в RSLinx.
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Multicast connection (групповое соединение) – Соединение от одного узла к 
нескольким узлам. Групповое соединение позволяет нескольким узлам-
потребителям получать данные от одного узла-производителя.
Multi-keeper device (мультикиперное устройство) – Означает, что несколько 
способных быть кипером устройств в сети могут хранить параметры сети ControlNet 
и расписание ControlNet для всех запланированных соединений в данной сети. Эти 
соединения могут включать, а могут и не включать само способное быть кипером 
устройство. 
В мультикиперной сети должно иметься как минимум одно действительное 
мультикиперное устройство, чтобы можно было установить новые запланированные 
соединения. 

В мультикиперной сети не требуется, чтобы устройство в узле 1 было 
действительным кипером; RSNetWorx for ControlNet может 
использоваться, пока в сети имеется одно мультикиперное 
устройство. По умолчанию, способное быть кипером устройство в 
узле с самым низшим номером будет единственным активным 
кипером. 

Node (узел) – Узел представляет собой адрес в ControlNet. Когда к сети добавляется 
устройство, вы назначаете ему адрес узла с 1 до 99. 
Network update interval (интервал обновления сети) – Интервал обновления сети 
(NUI) представляет собой один интервал работы сети, равный одному NUT. В 
пределах одного NUI передаются запланированные, незапланированные данные, а 
также информация по поддержанию работы сети. 
Network update time (период обновления сети) – Период обновления сети (NUT) 
представляет собой повторяющийся базовый интервал времени, в течение которого 
сеть может передавать данные. Он задается пользователем (в диапазоне от 2 до 100 
миллисекунд); значение по умолчанию составляет 5 миллисекунд. 
Каждый NUT подразделяется на три основных элемента: запланированные 
сообщения, незапланированные сообщения. поддерживающие сообщения. За 
дополнительной информацией по составным частям NUT обращайтесь к описанию 
обмена данными в сети ControlNet.
Peak scheduled bandwidth (пиковая полоса пропускания запланированных 
данных) – Выражается в процентах и представляет собой пиковую полосу 
пропускания запланированных данных для максимального, или худшего случая, 
интервала обновления сети в данной конфигурации. 
Point-to-point connection (двухточечное соединение) – Соединение только между 
двумя узлами.
Process control sample complete (выборка данных по управлению процессом 
сделана) – Используя несколько разрядов индикации состояния, PCSC уведомляет 
пользователя процессора PLC-5C, когда поступает определенная порция новых 
запланированных данных. 
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Producer (производитель) – Узел, отвечающий за передачу данных по сети Control-
Net.
Redundancy (резервирование) – Может использоваться для обозначения:
•    типа независимого соединения, при котором первичное и вторичное устройство 
совместно управляют выходами и посылают данные по конфигурации в сеть. 
Если у вас имеется соединение типа Redundant с целевым устройством, вы 
можете задать другое соединение типа Redundant с тем же самым целевым 
устройством, но не можете задать соединение типа Exclusive Owner. Этот тип 
соединения используется с системой горячего резервирования PLC-5 в Control-
Net (ControlNet PLC-5 Hot Backup system).

•    настройку двухкабельной системы, позволяющую получать оптимальный сигнал 
по сети ControlNet. В системе с резервированной средой одна кабельная система 
использует Канал A, а другая – Канал B.

Requested packet interval (требуемый межпакетный интервал) – Значение 
требуемого межпакетного интервала (RPI) определяется тем, насколько часто вам 
необходимо передавать определенную порцию ввода-вывода или запланированных 
одноранговых данных в течение полосы пропускания запланированных данных 
внутри NUI. 
RSNetWorx configuration (конфигурация RSNetWorx) – Набор параметров, 
задаваемых пользователем для сетей ControlNet.
Scanlist Configuration Tool (SCT) (инструмент конфигурирования Scan list) – 
Программа, организующая взаимосвязь областей памяти процессора с другими 
устройствами сети. SCT зависят от конкретного процессора, то есть для каждого типа 
процессора требуется уникальный SCT. 
Scanner (сканирующее устройство) – Устройство ControlNet, являющееся 
инициатором соединения. 
Scanner class device (устройство сканирующего класса) – Устройство, 
инициирующее соединения и содержащее Scan list. За дополнительной информацией 
обращайтесь к интерактивной обучающей программе по RSNetWorx for ControlNet. 
Scanner signature (сигнатура сканирующего устройства) – Представляет собой 
уникальное шестнадцатеричное значение, присваиваемое способным быть киперами 
устройствам, инициирующим запланированные соединения; копия сигнатуры 
сканирующего устройства хранится у активного кипера. Когда способное быть 
кипером устройство с запланированными соединениями впервые подключается к 
сети, оно запрашивает сигнатуру сканирующего устройства у активного кипера. 
Если внутренняя сигнатура сканирующего устройства совпадает с сигнатурой 
сканирующего устройства, полученной от активного кипера, то этому устройству 
разрешается открыть его запланированные соединения. Если же сигнатура сканера 
не совпадает, то этому устройству не разрешается открыть его запланированные 
соединения. 
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Scheduled bandwidth (полоса пропускания запланированных данных) – Объем 
запланированных (т.е. критичных ко времени) данных, включая данные ввода-
вывода и одноранговые данные блокировки, который может быть передан в течение 
интервала обновления сети (NUI). Процент использования полосы пропускания 
запланированных данных меняется в зависимости от конфигурации сети. 

Объем запланированных данных, который вы хотите передавать, 
может превысить полосу пропускания запланированных данных. 
Иными словами, скорость, с которой вы способны передавать данные, 
в какой-то мере определяется ограничениями вашей конкретной 
системы. Вы должны помнить об этом при настройке своей сети. 
Хорошим ориентиром при определении периода обновления (NUT) 
для вашей сети является значение в 0,5 мс на один рэк. 

Scheduled message (запланированное сообщение) – Предоставляет каждому 
запланированному узлу (циклически, в последовательном порядке) 
гарантированную возможность передачи информации. 
В течение этой составляющей интервала обновления сети (NUI) посылается 
критическая ко времени информация.
Single-keeper device (однокиперное устройство) – Означает, что способное быть 
кипером устройство в узле 1 должно сохранять параметры сети ControlNet, а также 
расписание ControlNet для всех запланированных соединений в сети. Эти соединения 
могут включать само способное быть кипером устройство, а могут и не включать его. 
Чтобы открыть всякое запланированное соединение в сети с одиночным кипером, в 
узле 1 должно находиться действительное однокиперное устройство. После 
установления запланированного соединения сеть будет продолжать 
функционировать даже после удаления однокиперного устройства в узле 1 из сети. 

В однокиперной сети устройство в узле 1 должно быть 
действительным кипером, тогда может использоваться RSNetWorx 
for ControlNet.

Slot time (временной квант) – Время ожидания пропущенного сетевого адреса и 
недостающего узла в сети. Это значение определяется физическими 
характеристиками сети, такими как длина кабеля и количество репитеров. 
Status file (статусный файл) – Статусный файл представляет собой задаваемый 
пользователем целочисленный файл данных, начинающийся с нулевого слова. В 
этом файле сохраняется информация о состоянии каждой индивидуальной записи о 
соединении в таблице отображения. Длина этого файла может варьироваться в 
зависимости от количества записей о соединении, при этом на каждую такую запись 
отводится три слова. 
Unscheduled bandwidth (полоса пропускания незапланированных данных) - 
Объем незапланированных (т.е. некритичных ко времени) данных, включая все 
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данные программирования и операторского интерфейса, который может быть 
передан в течение интервала обновления сети (NUI).
Unscheduled message (незапланированное сообщение) – Позволяет всем узлам 
(циклически, в последовательном порядке) передавать информацию. Цикл 
повторяется, пока не закончится время, выделенное на эту составляющую NUI.
Количество времени, выделяемое на эту незапланированную составляющую, 
зависит от информационной загруженности запланированной составляющей. В 
каждый такой интервал времени хотя бы один узел будет иметь возможность 
передать незапланированные сообщения. 
В течение этой составляющей интервала обновления сети (NUI) посылается 
информация, которая может быть доставлена с минимальными ограничениями по 
времени.
Valid keeper (возможный кипер) – Возможный кипер представляет собой любое 
способное быть кипером устройство, которое присоединилось к существующей сети 
и разделяет сетевую сигнатуру с текущим активным кипером, организовавшим сеть. 
Если активный кипер отсутствует на момент присоединения способного быть 
действительным кипером устройства к сети, то его сетевая сигнатура должна 
совпадать с сетевой сигнатурой, полученной любым другим устройством при его 
присоединении к сети. Возможный кипер автоматически возьмет на себя роль 
активного кипера, если текущий активный кипер выйдет из строя.  
В тех случаях, когда сеть состоит из возможных киперов или как возможных, так и 
недействительных киперов, возможный кипер, расположенный на узле сети с 
наинизшим номером, становится активным кипером. Если возможных кииперов в 
сети нет, то способное быть кипером устройство действует как кипер в отказе до тех 
пор, пока в сети не появится возможный кипер.  
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damaged (поврежденная) • 69

disk (диск) • 71

file (файл) • 24,65,71

key (ключ) • 65,71
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troubleshooting (возможные проблемы) • 68

utilities (утилиты) • 67 
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интервал) • 72 
adding a device (добавление устройства) •10 
anti-virus software (антивирусное программное 
обеспечение) • 66 
API • 72
auto insert devices (автоматическое добавление 
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autofax information system (автофаксовая 
информационная система) • 63 
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пропуская запланированных данных) • 72
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CHECKDRIVES • 65,68 
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32 
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clearing messages (очистка сообщений) • 59 
close (закрыть) • 6
communication service (служба связи) • 2 
compressing the hard drive (сжатие жесткого диска) • 
66 
configuration file (файл конфигурации) • 72

configuring (конфигурирование)
devices (устройств) •31 

connection (логическое соединение) • 72
connection configuration (конфигурация 
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connection settings (настройки соединения) •17 
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ControlNet concepts (общее представление о Con-
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copy protection (защита от копирования) • 65 
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D
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hardware devices (аппаратные устройства)

available (имеющиеся) • 9

favorite (избранные) • 9

hardware requirements (требования к аппаратным 
средствам)• 25 
hiding messages (скрытые сообщения) • 59 
HTML reports (отчеты в формате HTML) • 2

I

I/O data (данные ввода-вывода)• 2
informational messages (информационные 
сообщения) •12 
installation (инсталляция) • 23, 26

existing (существующая) • 28 

intended audience (целевая аудитория) • i 
invalid keeper (недействительный кипер) • 75

K

keeper signature (сигнатура кипера) •75 
KEYDISK • 68, 75

L

license (лицензия)  • 24, 75 
listing hardware devices (перечень аппаратных 
устройств) 

available (имеющихся) • 9

favorites (избранных) • 9

M

macrocycle •(макроцикл) •75
 maintenance message (поддерживающее 
сообщение) • 75 
master disk (мастер-диск)• 24,65,75 
maximize (развернуть) • 6 
menu bar (линейка меню) • 7 
message codes (коды сообщений) •12 
messages (сообщения) • 58

clearing (очистка) • 59

copying (копирование) • 59

hiding (спрятывание) • 59
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information (информационные) • 13,18

view (область просмотра) • 12 

minimize (свернуть) • 6 
mouse (мышь) • 25 
move (переместить) • 6
moving (перенос) 

activation (активации) • 24, 70 

multicast connection (групповое соединение) • 76 
multi-keeper device (мультикиперное устройство) • 
76

N
network (сеть)

activation (сетевая активация) • 68

opening a configuration (открытие 
конфигурации) • 8

usage (использование) •10

network update interval (интервал обновления сети) • 
76
network update time (период обновления сети) • 76
node (узел) • 76
NUI • 76
NUT • 76

O
offline (автономный) • 2
online (интерактивный) • 2, 9,16
Online Books (онлайновые книги) • ii, 62
online help (онлайновая справочная система) • i, 57
opening a network configuration (открытие сетевой 
конфигурации) • 8

P

pasting devices (вставка устройств) •8,16 
PCSC • 76 
PDF files (файлы PDF) • ii 
peer-to-peer data (одноранговые данные) • 2 
pointing device (координатно-указательное 
устройство) • 25 

point-to-point connection (двухточечное соединение) 
• 76 
printing a network configuration (распечатка сетевой 
конфигурации) • 8 producer (производитель) • 76

Q

quick start (быстрое начало работы) • 19

R

RAM . 25
redundant (резервный) • 76
refresh tree and diagram (обновление дерева и 
схемы) • 9
reinstalling DOS (переустановка DOS) • 66
release notes (информация о выпуске новых версий) 
• i
requested packet interval (требуемый межпакетный 
интервал) • 77
resetting activation (восстановление активации) • 68
resource usage (использование ресурсов) •17
restore (восстановить) • 6
restoring from backup (восстановление с резервных 
копий) • 66
RPI • 77
RSLinx • i,26
RSLogix 5 • 26
RSLogix5 • 2
RSNetWorx icon (иконка RSNetWorx) • 6

S
saving a network configuration (сохранение сетевой 
конфигурации) • 8,16
scanner (сканирующее устройство) • 77
scanner class device (устройство сканирующего 
класса) • 77
scanner signature (сигнатура сканирующего 
устройства) • 77
scheduled bandwidth (полоса пропускания 
запланированных данных) • 76, 78
scheduled message (запланированное сообщение) • 
78
scheduled node (запланированный узел) • 75

SCT • 77
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single keeper device (однокиперное устройство) • 78
size (размер) • 6
slot time (временной квант) • 78
software requirements (требования к программному 
обеспечению) • 25
spreadsheet view (табличное представление) •11
status bar (строка состояния) • 13,18
status file (статусный файл) • 78
step-by-step procedures (пошаговые процедуры) • 57
support library (библиотека поддержки) • 63
symbol legend (символьная легенда) •9 
system requirements (требования к системе) • 25

T

tasks (задачи) • 60
technical support (техническая поддержка) • 63 
telephone number (номер телефона) • 63 
title bar (линейка заголовка) • 6,15
training (обучение) • 62
troubleshooting (возмоджные проблемы) • 59

activation (при активации) • 68

installation (при инсталляции) • 29 

tutorial (обучающая программа) • ii, 62

U

uncompressing the hard drive (разуплотнение 
жесткого диска) • 66 
uninstalling (деинсталляция) 

DOS • 66

unscheduled bandwidth (полоса пропускания 
незапланированных данных) •78
unscheduled message. (незапланированное 
сообщение) • 79
unscheduled node (незапланированный узел) • 75, 76
upgrading the operating system (модернизация 
операционной системы) • 66
upload (загрузка) • 2

V

valid keeper (действительный кипер) • 79
VGA graphics adapter (графический адаптер VGA) • 
25

W

warning messages (предупредительные сообщения) 
• 12
Web address (Web-адрес) • 63
What's This? help (справка What's This?)• 58
Windows

2000 • 25

98 • 25,70

NT . 25,70

Z
zoom selection (выбор масштабирования)

zoom in (приближение) • 9

zoom out (отдаление) • 9
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За дополнительной информацией о последних ценах, 
а также с просьбами продемонстрировать какой-либо 
пакет Rockwell Software обращайтесь к своему местному 
тороговому представительству Rockwell Automation или 
дистрибутору продуктов Allen-Bradley. Самую свежую 
информацию о продуктах Rockwell Software можно найти 
на нашем web-сайте по адресу: 

www.software.rockwell.com

Обращайтесь к нам прямо сейчас по адресу
www.rockwellautomation.com
Когда бы вы к нам ни обратились, Rockwell Automation всегда 
готова предложить вам все лучшее в области автоматизации 
производства, включая средства управления Allen-Bradley, 
средства передачи электроэнергии Reliance Electric, 
механические элементы систем электропередачи Dodge, а 
также продукты Rockwell Software. Уникальный гибкий подход 
Rockwell Automation к поддержанию конкурентоспособности 
своих заказчиков находится на вооружении тысяч 
уполномоченных партнеров, дистрибуторов и системных 
интеграторов в разных странах мира. 

Центральное представительство по американскому региону: 1201 South Second Street, Milwaukee, WI 53204, USA, тел.: (1) 414 382-2000, факс: (1) 414 382-4444
Центральное представительство по европейскому региону: avenue Hermann Debroux, 46, 1160 Brussels, Belgium, тел.: (32) 2 663 06 00, факс: (32) 2 663 06 40
Центральное представительство по азиатско-тихоокеанскому региону: 27/F Citicorp Centre, 18 Whitfield Road, Causeway Bay, Hong Kong, тел.: (852) 2887 4788, 

факс (852) 2508 1846
Российский офис: "Рокуэлл Интернэшнл ГмбХ", 113054, Москва, Большой Строченовский пер. 22/25, офис 402тел. (095) 956-0464, факс. (095) 956-0469, 

e-mail software@rockwell.ru
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